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Figure1.1:
AQUATek 70 liquId VialAutosampler

AQUATek 70 accepts rinsewater
directly from atap water source using
an optional tap kit.Thetap kit simplifies
setup because It eliminates the need to
periodically check the water levelof an
external reservolr.The tap kit also
Includes a blankwater generator
eliminating the needto makelarge
volumesofVQC-free water.A rinse
reservoir kit Isalso available for labs
without a nearbywater source.

TekLink softwareIntegrates total
method control of AQUATek 70through
the WlndowsiIJ environment.It Inte­
gratescontrol of AQUATek 70,a 3000
Series concentratorand aWlndows­
based data system.

System Description

""".",.'.",."-.",_o""""""""w.,,'o,,'.,',,,,"••~_.w~.~,~",~~u...~1!~!~~~~~,~,DVIAL AUTOSAMPLER ~l~ INTRODUCTION.~_"""""""""""''''''''''',,",~,.,., .....,,,,_._....,,,.,...,....~ ...........,.,, ....._............_->..

-.,~..,~",••~,__"o ..•_,~,_. o_----_.'--~~-----....., ---

AQUATek 70 uses avial transport
system.Thesamplevial is not moved
because the sampleneedle (0) Is
brought to the vial.Thls eliminates
problemsof traditional vial
autosamplers such as vial jamming and
dropping caused byvial cap Incompat­
ibility and vial labels and alsoprevents
the particulate layers of ground water
samples from being disturbed.Large
bore tubing and large valveorifices
eliminatedogging of linesand valves.
Thesamplepathwayuses largebore
TefloniIJ tubing which IsInert,corrosion
resistant and easy to work with.

After the sampleIspurged,AQUATek 70
rinses the samplepath Including the
sample needle,transferline and
glassware with 90·C water. Water, not
water vapor, rinses the system anda
dual chamber heating system keeps
the water temperature high while
rinsingthe samplepathwayefficiently,
decreases blank runs and Improves

quality data.

AQUATek 70 processes water and
wastewatersamples of all types­
including particulate-ladensamples.
Theautosampler (0, Figure 1.1)
automatically removes a measured
amount of samplefrom eachvial and
the sample module (4D) addsa standard
solution (e) automaticallyto the
sample and then transfers It to the
concentrator.
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1..2 Specifications

SampleVials:
Nomlnal40ml capacity, single hole
capwith Teflon-faced silicone
septum,per EPA specifications. 3~

3/4" (9.5cm) high, 1-1/16" 0.0.,24
mm 10cap for water sampllnq,

Trays:
Accepts elthertwo 35-posltlon
traysor one optional 70-posltlon
vial cooling tray

VialCooling:
Optional vial coollnq tray to cool
vialsto 4°Casper EPA specifica­
tions. (Requires an external
recirculatIng cooling bath)

BathConnection:
Inlet and outlet hoseconnectIons
require 1/4" I.D.tublng. Bathmust
havea mInimum cooling capacity
of 300watts.

Liquid Samples:
Drinking water and wastewater
(watersamplescontaining sedl­
mentlevels of up to 15mmwhen
measured from the bottom of an
upright 40ml vial).

Sample Loop:
Interchangeable loops;5, 20 or
25ml volume, 1/8" 0.0., coiled.

Standard Injection System:
4-wayvalve,2 J..IL volume delivery.

Internal StandardAccuracy:
2J..1l+I-10%.

Internal StandardConsumption:
11 J..IL at 0.02mln Fill IS.
16J.1L at O.04min Fill IS.

Electronic Control:
Concentrator control ofoptically
isolated 1/0.

InstrumentControl:
AQUATek 70 iscontrollable with a
PC running TekLink software In the
Windows environment (Windows
3.1/95/98/NT).TekLlnk Integrates
control of the 3000SerIes Purge &
Trap Concentratorwith AQUATek
70.

Method Storage:
Upto 16methods Including pre­
programmedmethods.

VialSampling Device:
XYZ robot with statIonaryvIalrack
design capableof an accuracy of +1
- 1mm in XYZ dimensionsand
repeatabilityof +1- 0.25mm In
XYZ dimensions.

HighTemperature OptlRlnse™:
AQUATek 70 uses dual Internal
reservoirs which heat the water to
90°Cto cleanthe entire sample
pathway. (Includes sample loop,
sample transfer pathway,and
glassware on the concentrator).

Rinse Kits:
AQUATek 70 requires either atap
rinse kit or a reservoirkIt. These do

. not addadditional width sobench
space usedIsnot Increased.

Sample Path:
1/8" O.D.Teflon tubIng.

Valving:
Four12VDC,3-port solenoid valves.
One1151230 VAC motor actuated
4-port valve.

Contlnued.,
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Size:
Sample Module:
11" (27.9 cm)Wxl0.s" (26.7 cm)Dx
10" (25.4 cm)H
Autosampler:
21.1"(53.5 cm)Wx 17.2"(43.7 cm)D
x 14.6"(37.1 cm)H*
(* without vertical arm Installed)

Weight:
Sample Module:
1Sibs (6.8kg)shipping weight•
Autosampler:
120lbs(54.4kg) shipping weight.

Warranty:
Oneyearfull warranty.

Certifications:
CETL,CE

PowerRequirements:
1001115/230 VAC (+/~ 10%)factory
configured.
50/60 HZ,100VA.

EnvironmentRequirements:
Operating temperature:
10°Cto 30° C.
Storage temperatu re:
-20°Cto 60° C.
Relative humidity:
10to 90%with no condensation.

Gas Requirements:
Ultra-high purity (99.9990tiJ pure)
helium, 25 - 60 psl, •
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1.3 Safety
/

& Indicates potentialfire hazard.

Please be awarethat If the AQUATek 70,
Its components,and/or accessories are
used In a manner not specified by
TeleclyneTelanar, protection pro-
vided bythe equipment may be
Impaired.

SafetyWarnings

Warnings In thisdocument or on the
Instrument must be observedduringall
phases ofoperation,service, and repair
of this Instrument. Failure to comply
withthese precautions violates safety
standards ofdesign and the Intended
use ofthe Instrument.

WARNING

Awarning calls attention to a condition
or possible situation that could cause
Injury to the user.

CAUTION

A cautioncall attention to a condition
or possible situationthat could damage
or destroythe product or the user's
work.

Caution. Refer to
accompanying documents.

Indicates a hot surface.

Indicates hazardousvoltage.

Indicates explosion hazard.
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CAUTION

Some parts Inside AQUATek 70get hot.
Toprevent burn InjUry, allow AQUATek
70to cool beforeyou removethe
exterior panels.

WARNING

Toavoid electrical shock:

Turnoff and unplug AQUATek 70 and
anyother peripherals beforeservicing.

Do not process samples without the
panels Installed.

Plugthe power cord Into a properly
grounded outlet.

oIol<..............., ...._" .;....--- ~ ; ------------------

WARNING

NEVER usehydrogen or other flam­
mablegaswIth the AQUATek 70and Its
perIpherals.

Followthe manufacturers'dIrectIons
for safe handling of gasand chemIcals.
Also referto Material Safety Data
Sheets for Information on specific
chemicals.

Forcontinued fire protection, replace
wIth same type and rating offuse.

Do not exceed recommended pressure
settings.

Observe safetyregulationswhen
handling pressurized gas.Formore
Information,see Matheson Gases Data
Book(available from the Matheson
Company, East Rutherford, NewJersey).

An extensIon cord mayoverheat and
cause a fire.Do not plug AQUATek 70 or
Its peripherals Into anextensIon cord.

WARNING

Samples and samplewastemaycontaIn
hazardous and toxic substances. Follow
proper safetyand health practices. Also
know regulatory limitations before
usingor disposIngof chemIcals.

Do not useIn a confined space as
nitrogen cancause suffocationIf
accumulated to high levels.
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2.1 Overview

2-3
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This sectiondescribes the steps
necessary to prepareyour site for
installation,unpack the samplemodule
and autosampler,and set up the
AQUATek 70system.

Perform the system setup and installa­
tion in the sequence presentedin this
section.

Start-up assistance isavailable through
TeledyneTekmar or an authorized
representative.

After meeting all utility and facility
requirements, contactTeledyne
Tekmaror an authorized represen­
tative to schedule onslte Installation
and start-up assistance. Please provide
adequateadvancenotice to avoid
undue delayIn processing your
request.

Thesamplemodule (0, Figure ,2.1) and
the autosampler (4D) composethe
AQUATek 70 Liquid Autosampler
system and ship together.Each compo­
nent Isreferred to as samplemodule
and autosampler, respectively, through­
out the remainderof this usermanual
and supporting documentation.

Figure2.1:
AQUATek 70 liquid Vial AutosamplerSystem
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CAUTION
Samples and sample wastemay
contain hazardous and toxic
substances. Followproper
safety and health practices.
Also, know regulatory
limitationsbeforeusingor
disposing of chemicals. Do not
use in a confined space as
nitrogencancause suffocation
If accumulated to high levels.

To preventexplosIon and fire:
• Never usehydrogen or other ­
flammable gas with AQUATek
70.

• Follow the manufacturers'
directionsfor safe handling of
gas and chemicals. Also, refer
to Material Safety Data Sheets
for Information on specific
chemicals.

•Donot plug the sample
moduleor autosampler Into
anextension cord. An
extension cord mayoverheat
and cause a fire.

• For continued fireprotection,
replace with same type and
ratingoffuse.

To avoidInjury to yourselfor
damage to the concentrator
and the AQUATek 70:
•Donot exceed recommended
pressure settings.

•Observe safety regulations
when handling pressurized
gas.

•Wear safetyglasses when
operating, maintainingand
servicing AQUATek 70.

Some parts inside the sample
module get hot.To prevent
burn Injury,allow the sample
module to cool beforeyou
removethe exterior panels.

To avoid electrical shock:
•Turnoff and unplug the
sample module and
autosampler before servicing
or routine maintenance.

• Do not process samples
without the panels installed.

• Plugthe power cord Into a
properly grounded outlet.

Use of the AQUATek 70 liquid
Autosamplersystem and/or its
accessorIes In a mannernot
specified by Teledyne Tekmar
could Impair the safety features
of the Instrument, result in
serIous injury, and/or void the
warranty.

CAUTION
Twopeople are necessary to 11ft
the autosampler out of the
shipping carton and onto the
bench.Arrange to have
someone assist you with
unpacking and bench
placementof the autosampler.

CAUTION
Thesample module shIps with
the Internal standard(IS)
glassware installed.Use caution
when removing the sample
module from the shipping
carton and when placing It on
your workbench to avoidglass
breakage and possible personal
Injury.

Safety2.2

2-4
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2.3 Dimension and Weight
Specifications

Dimensions:

SampleModule:

11" (27.9 cm)Wx 10.5" (26.7 cm)D x
10" (25.4 cm)H

Autosampler:

21.1" (53.5 cm)Wx 17.2"(43.7 cm)D
x 14.6"(37.1 cm)H*

(* without vertical arm Installed)

Weight:

SampleModule:

151bs (6.8kg) shipping weight.

Autosampler:

120lbs(54.4kg) shipping weight.

2.4 Utility Requirements

Environment

Operating temperature:

1O°C to 30°C

Storagetemperature:

-20°C to 60°C

Relativehumidity:

10 to 90%with no condensation.

Gas

99.999% Heor N2 gasat 20 pslg

Power

SampleModule

Voltage:.

100/115/230 VAC (+/- 10%)factory
configured; 50/60 Hz,5.0/2.5amps,
575 watts.

100/115V:

50 or 60 Hzsingle-phasepower
sourceat 100/115V+/- 10%;
Maximum current draw is 0.86
amps and maximum power
consumption Is100watts; 1.0A
250Vfuse,factory configured;
Powercord Isterminated with a 3­
prong straight blade plug (safety
feature) and requiresamatching
receptacle.

230V:

50 or 60 Hzsingle-phasepower
sourceat 230V+/-1 0010; Maximum
current draw is0.43amps and
maximum power consumption Is
100watts.

Autosampler:

Voltage:

100/1201230 VAC (+/-10%)

100/120V:

50/60 Hz;2.0A fuse

220/240V:

50/60 Hz;1.0A fuse



2.5 Tools Needed for Setup
and Installation

Utility knife or scissors

• Large Phillips head screwdriver

• Small Phillips head screwdriver

Medium slotted screwdriver

7/16"open end wrench

,• 5/16"open end wrench

2-6

2.6 Unpack and Inspect
AQUATek70

Note:

Retain all shipping materials.

1. Open the top of the AQUATek 70
shipping carton.

2. Remove the two kit boxes located
on the top layer of the carton.

3. Inspect each kit box to make sure
that all parts listed on the packing
list are present. If you believe you
are missing any parts, please call
the TeledyneTekrnar Customer
Support Center Immediately at
(800) 874-2004.

4. Remove the foam insert above the
sample module and set aside.

5. Carefully slide your hands under­
neath the sample module (not near
the glass ISvessel),11ft out from the
carton, and set on the bench.

6. Remove the plastic wrap from the
sample module.

7. Remove the foam insert that was
underneath the sample module
from the carton and set aslde.

8. Remove the autosampler vial tray
box from the carton.

.
9. Removethe trays from the box,

remove the plastic wrap, and set
the trays on the bench.

10. Remove the two cardboard inserts'
from the shipping carton and set
aside.

Continued...
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16. Carefully peel off the tape that
securesthe autosampler kit
contents and discard.

17. Removethe plastic wrap from the
autosampler kit contents and set
aside.

18. Checkthe autosampler kit contents
against the packing list. If you
believe you are missing any parts,
pleasecall the Teledyne Tekmar
Customer Support Center immedi­
ately at (800) 874-2004.

12. With one person holding the
shipping carton stll1, the other
person should carefully slide the
autosampler box out from the
shipping carton.The autosampler
box fits snugly Inside the carton
and may be difficult to remove•

13. Carefully tilt the autosampler box
to Its upright position and open.
The words"Top Freight Onlyn
should now be on top of the box.

14. With the other person, carefully
remove the autosampler from the
box by lifting It out by its base.

11. With help from another person,
carefully tilt the shipping carton on
its side so that the autosampler
box Issitting upright.The words
"Top Freight Only" should not be
upside-down when looking in the
carton.

·hiHuyrtt' .""j 11'.,.:11:';# 1m iJ ItUIlSJlUtl,g: iEiNrr1rl lltl nmra" 'T i Ui .R~ltfil ~%'1:iJj)olf'!j'lT"f'pr!!lJ'E~!'lJI\"'rl' ·1 !,~~~'!:"'?!':;,
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Importantl
Never lift or move the
autosampler by Its horizontal
arm.

15. Set the autosampler on the bench.

Note:
If you do not have adequate access to
the autosampler rear panel, you may
want to set the autosampler on the
bench at an angle so that you can
access the rear connections during
setup.

•
~
~
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Figure 2.7.1.2:
Store the ArmLocking Screw

Figure 2.7.1.1:
Remove the Arm Locking Screw

..
fI/I1P..
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filii'
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Autosampler Setup2.7.1

Remove and Store the Arm Locking
Screw

1. Remove the plastic arm locking
screw cap (0, Figure 2.7.1.1) from
the right side of the autosampler
and retain.

2. With a large Phillips head screw­
driver, remove the arm locking
screw (f)).

3. Replace the plastic arm locking
screw cap (e,Figure 2.7.1.2)to the
right side of the autosampler.

4. Insert the arm locking screw Into
its storage location (0) located on
the rear panel of the autosampler.

2.7 System Setup

PleaseInstallthe AQUATek 70 system In
the order described In this section.

Ifyou have any questions or need
technical assistance,please call the
TeledyneTekmarCustomer Support
Center at (800) 874-2004.

2-8
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SW1 SW2

Figure2.7.1.5: I
AutosamolerUnit ID and B.1ud RateSettlnas

Set the Unit 10 and Baud Rate

1. With a small Phillips
screwdriver, set the unlt 10
(SW1) selector on the rear of
the autosampler to 0 (Figure
2.7.1.5).

2. Set the baud rate/mode (SW2)
selector to 4 (Figure 2.7.1.5).

AQUATEK 70LIQUID VIAL AlJTOSAMPLER ~" SYSTEM SETUP

.,},.JJ.;';-,rj "~,:",~,, ",'.~ 11" .~,

1. Locate the accessorypackage
containing the fuse drawer
appropriate for your line voltage.
Discard the other fuse drawer.

2. Locate the accessorypackage
containing the 2.0Afuses.

3. Install the fuse(s} Into the fuse
drawer•

a} The fuse drawer for 115V
accepts one fuse (Figure
2.7.1.3).

b) The fuse drawer for 230V
accepts two fuses (Figure
2.7.1.4).

4. Insert the fuse drawer Into Its
receptacle In rear panel of the
autosampler•

You receive the autosampler without
any fuses Installed.

Install the Fuse(s)

......
.~

~...­..............
•.......
•..........

.....1. Figure2.7.1.4:
AutosamplerFuse Installation for 230V



Figure 2.7.1.7:
Vertical Arm Installation; Attach the VerticalArm

6. Usethe supplied screws to secure
the vertical arm tothe horizontal
slider. Insert the screws up through
the bottom of the mounting holes
(f) of the horizontal slider.You
may need to move the vertical arm
back and forth slightly to align Its
mounting holes with thoselnthe
horizontal slider.

7. Re-Insert the control rod asfar as It
will go.While insertingthe control
rod,you may need to rotate it back
and forth slightly to get It to pass .
through the gearing and motor
drive socket In the horizontal slider.

4. Pull the probe foot towardsthe
front of the horizontal arm asfar as
it will go. .

5. Position the vertical arm (0, Figure
2.7.1.7) onto the horizontal slider
(0).When viewed from the front of
autosampler, the needle holder
bracket (CD) of the vertical arm is on
the right.

Figure2.7.1.6:
Vertical Arm Installation; Remove ControlRod

3. Using your finger, presson the
control rod where It passes
through the horizontal slider.At the
same time, pull the probe foot (CD)
towards the front of the horizontal
arm.Thls causes the white plastic
plug (0) and control rod to move
forward slightly.When the white
plastic plug Isno longer flush with
the front of the horizontal arm,
remove It and remove the control
rod from the horizontal arm.

2. locate the hexagonal-shaped
control rod (0) and horizontal
slider (fD) by looking down Into the '
horizontal arm.

Install the Vertical Arm

•__________._w.._~ If

•,..,
\..,

"""~
~

C'..
fl'

".........
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~"'
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•..
fI!i'
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Contlnued._

Note:
Before Inst~lIIng or changing the
vertical arm,ensure that horizontal arm
moves freely.

1. Removethe three small screws(0,
Figure 2.7.16)from the front cover
plate (e) of the horizontal arm (f)
with a small Phillips screwdriver
and set the screws and cover plate
aside.



AQUATEK 70 LIQUID VIAL AUTOSAMPLER ~It SYSTEM SETUP

8. Apply pressure at the baseof the
vertical arm and push the vertical
arm to the back of the horizontal
arm.

9. While slightly moving the probe
holder bracket up and down, push
the control rod until It clicks Into
position.

10. Replace the white plastic plug.

, t. Replace the cover plate to the front
of the horizontal arm with the
three screws.

Install the Needle Holder Assembly

r, Thread the plastic needle guide
nut (0, Figure 2.7.1.8) up through
the probe foot (f) untllflnqer­
tight.

01----...

Figure 27.1.8:
Install the Needle HolderAssembly

2. Slide the needle holder bracket ($)
up to the top position of the
vertical arm.

3. Removethe needle thumbscrew
(0) from the front of the needle
holder assembly (CD).

4. Snap the needle holder Into the
back of the bracket making sure
the thumbscrew holes align.

5. Re-Insertthe thumbscrew Into the
bracket,but do not tighten fully.

2-11
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Install the AutosamplerTray

The tray positions the vial racksthat fit
onto the bed of the autosampler and
contains liquid spills that may Occur.

1. Install the tray in the lower position
on the tray mounting brackets (0,
Figure 2.7.1.10).

2. Make sure that the tray fits securely
and that the drain outlet (fD) Is
located at the left rear of the tray.

Install the Sample Needle Assembly

1. Slide the needle assembly (0,
Figure 2.7.1.9) down through the
needle holder(fD) and needle
guide nut (e) making sure that the
side pressure port (0) faces out
and that the sample needle is
centered and just barely within the
the needle guide.

FIgure 2.7.1.9:
Install the Sample Needle Assembly

2. Securethe needle by tightening
the needle thumbscrew (4D).

Note:
Do not over-tighten the needle
thumbscrew; doing so may damage
the sample needle.

2-12
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Figure2.7.1.12:
Connect Drain Tubing to Drain Outlet

4. Feed one end of the drain tubing
(0, Figure 2.7.1.12)over the drain
outlet (8)) of the rinse station
and place the other end Ina
drain receptacle, located lower
than the tray.

2-13

Figure 2.7.1.13:
Conne<;t Rinse Stationand Support

I r Fr

5. Secure the support bar to the
top holes of the two front
standoffs (0, Figure 2.7.1.13)and
tighten the two front support bar
thumbscrews ($).

Figure 2.7.1.11:
Assemble Rinse Station;Attach to Support Bar

AQUATEK 70LIQUID VIAL AUTOSAMPLER ~f: SYSTEM SETUP

Install the Rinse Station, Drain Tube,
and Support Bar

1. Makesure that the rinse station
body Is positioned the correct
way(O, Figure2.7.1.11).

2. Pre-assemble the rinse station in
this order:thumbscrews (e),
rinse station body,washers ($),
and a-rings (0).

3. Secure the rinse station assembly
to the back of the support bar
(41) between positions 3 &4 (0)
and 4 & 5 (0) and tighten the
thumbscrews (&).

If,.,. L"
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Install the AutosamplerTublng
Support Rod

1. Placethe magnetic baseof the
tubing support rod on the top of
theautosampler.

2. Route the sampler tubing around
the support rod to 'keeptubing out
of your workspace and so that the
tubing does not Interfere with the
movement of the horizontal arm.

2-14

2.7.2 Sample Module Setup

Position the Sample Module onto the
Autosampler

1. Turn the autosampler around
so that you can place the
sample module onto the
autosampler base.

2. Locate the VelcroGD strip at the
bottom of the sample module.

3. Remove the adhesive backing
from the Velcro strip and
discard.

4. . Place the sample module (IS
glassware facing toward you)
on the autosampler (left of the
vial tray).

5. Apply slight pressure to the top
of the sample module to
ensure the Velcro adhesive
sticks to the autosampler base.

'-I.
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2.7.3 Install the AQUATek 70 Logic
Card In the Concentrator

You must Install the AQUATek 70 logic
card In the concentrator so that the
concentrator can communicate with
the sample module and autosampler.

CAUTION.M. Staticdischarge can damage the
logic card.

Beforehandling the logic card
or touching anyInternal
components,discharge your
body's staticelectriccharge by

. touching agroundedsurface.
• If available, wearagrounding

strap.Whenhandlingthe logic
card, hold It by the edgeand
metal mounting bracketonly.

• Avoid touching components on
the card and the edge
extendersthat plug Into the
mlcrocontroller expansion slot.

1. Make sure that the concentrator,
computer (If connected), and any
other peripherals are powered
off and unplugged from their
power source(s).

2. To loosen the right corner
(trap) panel of the concentra­
tor.loosen the two 1/4-turn
screws on the front of the trap
coverpanelofthe
autosampler.

3. Slide the panel forward and
then to the right to remove It.

4. To remove the top panel of
the concentrator, pull It
forward until It stops and then
11ft It up.

5. Remove the thumbscrew
holding the top ofthe right
side panel.

6, Lift the right side panelawayfrom
the concentrator to expose the
logic card slots.

7. Locate an unused card slot (0,
Rgure 2.7.3.1) on the back of the
concentrator, remove Its screw (CD),
and cover plate (fD).

8. Carefully slide the AQUATek 70
logic card straight Into the concen­
trator mlcrocontroller board (0).
Make sure that none of the card
pins bend or break off. Make sure
the logic card Is well seated In the
microcontroller board.

9. Secure the logic board to the case
with the cover plate screw.

10. Reversesteps 2-6 to replace the
concentrator panel.

S. lhermocoupl.
Condition« card

6. GClnterfa<:. card
7. M-morycard

2-15



2.7.4 Make Electronic Connections

Connect the Sample Module and
Autosampler I/O Cables

1. Connect the 25-pln male end of
the 25 to 9-pln I/O cable to the port
labeled RS232 (0, Figure 2.7.4.1) on
the rear panel of the autosarnpler,

2. Connect the 9-pln female end of
the 25 to 9-pln I/O cable to the port
labeled Autosampler (fD) on the
rear panel of the sample module.

3. Plug the appropriate power cords
Into the sample module and the
autosampler.

Note:

Do not plug the unit power cords Into
the power source at this time.

,------.~.25------

PC

GC

Agure2.7A.1:
VO Cable Connections

2-16

Connect the Sample Module and­
Concentrator I/O Cable

1. Remove the two standoffs from the
female end of the 25 to 25-pln I/O
cable.

2. Connect the 25-pin female end of
the VO cable to the AQUATek 70
logic card port (e) on the rear
panel of the concentrator.

3. Connect the 25-pln male end of
the I/O cable to the port labeled
Concentrator (O)on the rear panel
of the sample module.

,---25.25----

Autosampltr
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FlgurI! 2.7.5.1: Pneumatic Connections

AQUATEK 70LIQUID VIAL AUTOSAMPLER ,I, SYSTEM SETUP

".... RtguIalof

~
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InWnIl ' ....d v.....

Pralurta\lllll VIM Swtlth

ferrule fitting to the standoff
flngl!r-tlght.

3. Connect the 1/16" line from the NS
Needle port (0) to the side port
(CD) ofthe autosampler needle
assemby.Secure the nut flnger­
tight.

Connect Gasto Sample Module

1. Make sure the supply gas is turned
off before continuing.

2. Remove the brass cap from the
port labeled Gas In on the rear
panel ofthe sample module.

3. Swage the 1/8"brass Swagelok~
nut and ferrule to end of the
copper 1/8"carrier gas tubing.

4. Using a 7/16"wrench,connectthe
Swagelok fitting to the port labeled
Gas In (0) on the rear panel of the
sample module 1/4 turn past
finger-tight.

1/10'~ fI",",,, LInt (To CanclnlrIlOl)

4··········_·······
IINItdT,nt"
LInttoOC

.-

Route the 1/8" line from the port
on the rear panel of the sample
module labeled GasOut (0) to
vent.

2-17
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Connect Sample Lines from Sample
Module to Autosampler Needle

Two sample lines (1/16"and 118") exit
the sample module (NS Needle) and
connect to the autosampler needle.

1. Connect the 1/8"line from the port
on the rear panel of the sample
module
labeledNS
Needle (f)
to the top of
the
autosampler
needle
assembly
(6).

2. Pull up the
standoff on
the top of
the needle
assembly
and tighten
the plastic
nut and

2.7.5 Make Pneumatic
Connections

Connect Pressurized GasLine

If you are using the optional Rinse
Reservoir:

Connect the 1/8" line from the port
on the rear panel of the sample
module labeled GasOut (0, Figure
2.7.s.1) to the rinse reservolr port
labeled Gas In.

If you are not using the optional Rinse
Reservoir:
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Connect Water Supply to Sample
Module

1. Remove the brasscap from the
port labeled Water In ($, Figure
2.7.6.1) on the rear of the sample
module.

2. Swagethe 1/8"brassSwagelok nut
and ferrule to end of the water 1/8"
supply tubing.

3. Using a 7/16"wrench, conneet the
Swagelok fitting to the port labeled
Water In on the rear panel of the
sample module 1/4 turn past
finger-tight.

Connect the Sample Module Drain
line

1. Slip one end of the 1/4"00 1/8"10
Tygonll tubing over the port
labeled Drain (fD) on the rear panel
of the sample module.

2. Runthe other end of the drain line
Into the waste container, Make
surethat the drain tubing will not
fall below the level of the waste
liquid.

2.7.6 Connect Water Supply and
Drain Line to Sample
Module

Note:

If you are Installing either the AQUATek
70 External Tap Kit or the AQUATek 70
Rinse Reservoir Kit, pleaserefer to the
Instructions that came with the kit for
setup details.

Figure2.7.6.1:
WaterSupply Connection

Important!

If you are not using an external reser­
voir kit, make sure that the toggle valve
on the rear of the sample module (0,
Figure 2.7.6.1) Isset to VENT.
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Rgure 2.7.7.2:
Install Concentrator
Sparger with SideArm
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3. Loosen and remove the.1/16" nut
and ferrule from the top of the
sample mount fitting (e).

4. Loosenthe #6-32 thumbnut that
securesthe sample valve/needle
assembly (0) and remove the
assembly by sliding upward and
out of the sample mount fitting.

5. Loosen the 1/2" nut (CD) on the
bottom of the sample mount
fitting. Remove the sparger by
gently pulling downward.

Install Sparger (with Side Arm)

1. Insert the sparger (with side arm)
up Into the sample mount fitting
(0,Figure 2.7.7.2).

2. Tighten the 1/2" nut finger~tl9ht
(e}.The sparger must be "seated"
correctly In the sample mount
fitting to ensure a leak-tight
connection.

Figure 2.7.7.1:
Remove non-AQUATek 70
Spargerfrom Concentrator

2.7.7 Install the Concentrator
Sparger, Needle, and
Connect Sample Line

Depending on the AQUATek 70 system
you ordered, you received either the
5mL or 25 mL sparger (with side arm)
sample glassware for your concentrator.
AQUATek 70 requires the sparger (with
side arm) for operation.

If you ordered a 25mL system, you will
also have to replace the 5 mL concen­
trator sample needle with the the 25mL
needle you received.

Remove Existing Sparger

1. Disconnect the drain line from the
female luer connector of the
sample Inlet valve (0, Figure
2.7.7.1).

2. Loosen the 1/4" nut (f)} on the
sparger end of the purge line and
remove the purge line.



Replace Sparger Needle

1. Loosen the black thumbnut (0,
Figure 2.7.7.3) on the bottom of the
sample Inlet valve/needle assem­
bly (&).

Figure 2.7.73:
Replace Sparger Needle

2. Gently pull the old needle ($) and
ferrule out ofthe sample inlet
vaIve. Check the orientation of the
needle ferrule so that you Install
the new one in the same way.

3. Holding the new ETEF (blue) ferrule
in the proper orientation, slide It
onto one end of the new needle
and insert the needle into the
bottom port of the sample inlet
valve.

4. Slide the black thumbnut onto the
needle and secure It finger-tight
Into the sample Inlet valve.

5. Slide the 1/16" nut and the 1/16"
one-piece ferrule (white) (0) onto
the needle.

6. Insert the needle through the top
of the sample mount fitting (0)
and securethe assembly in place
with the #6-32 thumbnut «(D).
Make sure that the sample needle
Isfar enough down into the
sparger.

7. Seal the needle to the sample
mount fitting by tightening the
1/16" top sample fitting nut (0)
finger-tight plus l/4-turn with a
S/16"wrench to ensure adequate
draining.

Reconnect Drain and Purge Lines

1. Re-attach the 1/4" nut end of the
purge line to the sparger and
tighten finger-tight.

2. Re-attach the drain line to the
sample Inlet valve finger-tight.

Important:
.Make surethat the sample inlet valve
atop the concentrator sparger assembly
Isopen to Drain.

...,
~
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2.7.8 Power Up and Set System
Pressure

1. Power up the system In.the
following order:

a) Autosampler-the sample
needle will move to the home
position and the LED on the
top left of the autosampler will
glow.

b) Sample Module-the power
status LED on the front of the
AQUATek 70 will glow.

c) Concentrator-the concentra­
tor will run through Its self­
test.

2. Turn the carrier gas and water
supplies on.

3. Using the pressure regulator on the
front of the sample module, adjust
the pressure until the system
pressuregauge reads20ps!.

Note:
TeledyneTekmar recommends that
the system pressurefor all AQUATek 70
applications be set at 20psl; higher
pressures can result In the failure of
some valves.

Figure 2.7.7.4:
ConnectSample LInefrom Sample
Module to Concentrator Sparger

Connect Sample Line from Sample
Module to Concentrator

1. Attach the reducing fitting, (0,
Figure 2;7.7.4) onto the end ofthe
tubing that exlts the port labeled
ToConcentrator on the front panel
of the sample module.

2. Place the fitting over the sparger
side arm ($).

3. Feed the tubing through the fitting
and Into the arm until the tubing
Justenters the sparge bulge ($)
beneath the knurled nut (approxi­
mately 1/rintobulge).

4. Tighten the reducing fitting flnger-
tight.

Note:
Do not usea wrench to tighten the
fitting further; doing do may damage
the sparge arm and cause Injury.

5. Make sure the sample Inlet valve
(0) Isset open to Drain.

6. If you are not using an external
reservoir kit, make sure that the
toggle valve on the rear of the
sample module Isset to VENT.
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2.7.9 Prepare Sample Module
Internal Standard

The sample module ISvalve dispenses
an aliquot of Internal standard (IS)
when the ISparameter Isactivated In
the TekLink Method Editor screen.

1. Create the standard as prescribed
by Its method.

2. Add ISmixture to the 20ml sample
module ISvessel.

3. Carefully slide the ISvessel up onto
the standard fitting on the front of
the sample module until the top lip
of the glass ISvessel makes contact
with the Internal mount.

4. Tighten the sample mount fitting
finger-tight.

5. Turn the knob on the front of the
sample module to Pressurlze.The
small line etched Into the knob
Indicates direction.

6. Make sure that the 5/16"nut at the
top of the ISmount is leak-tight by
tightening It 1/4 turn with a
wrench.

Note:
The ISIs under constant pressure when
the gas supply remains on and the front
toggle switchIs set to PRESSURIZE.

Importantl
When replacing or servicing IS,make
sure switch Is set to VENT.

2-22

2.7.10 leak Check AQUATek 70

Note:
Pleaserefer to the procedures In
Section 4.12 and check point diagrams
in Section 5.3 for more comprehensive
leak checking Instructions.

Allow the concentratror,sample
module, and autosampler to warm up
for at least thirty minutes before you
leak-check the system. If you leak-check
the system before the fittings have had
time to reach operating temperature
and expand,you will find leaks.A useful
leak checking tool Isan electronic
helium leak checker.

Importantl
If you tighten fittings before the system
has pressurized and warmed to
operating temperature, you can
severely damage the ferrules inside the
nuts.You could also strip the threads on
the nuts and not be able to remove
them.

Usean electronic thermal conductivity
detector and helium as the pressurizing
gas. If an electronic leak detector Is not
available, use a 1:1 solution of
Isopropanol and water. Apply a drop or
two of the solution to the suspect
fitting. If the solution bubbles, there Is a
leak. Usethe solution sparingly to
prevent contaminating the fittings.

Important!
D·o not use any type of soap solution
(for example, Snoops) to check for
leaks.If soap gets In the lines, It will
cause Increased background,adsorp­
tion, and other analytical problems.

If you are unable to determine and/or
solve a leak problem, please contact the
Customer Support Center at (800) 874­
2004.
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2.7.11 Check Gas Flow Rates

Note:
Please refer to the procedures in
Section 4.13 and check point diagrams
in SeetlonS.4 for more comprehensive
leak checking Instructions.

Gasflow rate problems can be caused
by tubing restrictions, bad valves,loose
or bad fittings, and other conditions.

Allow the concentrator, sample module,
and autosampler to warm up for at
least thirty minutes before you check
gas flow rates.If you check system gas
flow rates before the fittings have had
time to reach operating temperature
and expand, you might obtain false
flow rate readings. Use a gas flow meter
to measure gas flow rates.

If you are unable to determine and/or
solve a gas flow rate problem, please
contact the Customer Support Center
at (800) 874-2004.
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StartTekLlnk

Select Start> Run...

Install TekLink

Choose Start> Programs>TekLink.
Select theTekLink programfile.

In Program Manager,double--cIlck
on the Tekllnk programfolder and
then double-clickon the Tekllnk
icon•

•

• Select File> Run In Program
Manager•

Windows95/9B/NT:

Windows95/98/NT:

•

Windows3.x:

•

3.1.4

4. Followthe installationscreen
prompts.

Tekllnk installsonto the drive and
directory you specify. Whensuccess­
fully Installed, the TekLink Iconwill
appearin its own programgroup in the
Program Manager (Windows3.x) or in
Start> Programs> TekLink (Windows
95/9B/NT).

3. TypeA:\sETUP or B:\SETUP (de­
pending on the driveyou are
using) in the Run dialog box and
click OK.

1. Insert the backupcopy ofTekLink
Into the appropriatefloppy drive.

2. BegintheTekLink Installation:

Windows3.x:

3.1.3

Make Backup Copy of
Installation Disk

System Requirements

Install TekLink

-~--,.._,---------_._-------~--

Note:
MicrosoftWindowsversion3.1 (or
greater) or Windows 95 must be
Installedon your computer beforeyou
can installTeklink.

Before you InstallTekLink onto your
harddrive,makea backup copyof the
diskette(s) and usethe backupfor
Installation.Wrlte--protect your backup
copyto protect it from accidentally
being copied over.Storethe original In
a secure place.

3.1.2

3.1.1

To install and useTeklink, you needan
B03B6 or higher computer with
Mlcrosoft.Wlndows 3.1 or greater
installed.Yoursystem should have a
harddrive that has at leasttwo mega­
bytes (MB) of free space and afloppy
diskdrive that reads 1.44MB (3112")
diskettes.

3.1

This section offers Information and
instructionson system requirements,
making a backupcopy of the program
disk, and installingTeklink onto your
harddrive.
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3.2.1 Important Information for
3000 Customers

TekLink 3000/3100 isdesignedto run
AQUATek 70 with all 3000/3100
concentrators.The 3000/3100 memory
board ROM must be flash upgraded in
order to recognize and run the
AQUATek70.

If you purchased a 3100at the same
time as AQUATek 70,the 3100 memory
board ROM (Version 5.17) Iscurrent
and doesnot needto be flashup­
graded.To determine the current
version of the 3000/3100 ROM, launch
TekLlnk and selectHelp> About
TekUnk.The ROM versionIs listed after
"3000/3100 Firmware Version". If the
version isearlierthan 5.16(3000 units)
or 5.17 (3100 units), then you must
flashupgradethe ROM.

Flash upgrading the 3000/3100
memory board ROM is easy with the
Flash softwareprogram Included In

, TekLink andthe separate 3000/3100­
AQUATek 70 Flash Upgrade5.16 (3000)
or 5.17 (3100) file:

3000: 30_516.bln

3100: 31_517.bin

3.2 Configure TekLink

Tekmar 3000/31 00 Series concentrators
process liquid or soli samples for
analysis by gaschromatography and
operate automatically, under micropro­
cessor control, to process a singlefront­
panel sampleor multiple samples
loaded from AQUATek 70. When
programmed with custom methods,
this system can operateat different
time and temperature parameters and
run different analyticalsequences on
specifiedsamples.

You canprogram custom operating
sequences for up to four concentrators
by using a personal computer running
TekLlnk.TekLlnk makes It possiblefor
you to usea personal computer
running Microsoft Windows to monitor,
schedule, and control the operation of
one,two, three,or four concentrators.

Before you begin setting up methods
and running samples, pleasefamiliarize
yourself with the TekLlnk software as
described in this section. TekLink must
recognize the concentrator and be
configured correctly for the AQUATek
70system to run properly.

------------------,--- ---,-- ,----
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3.2.1.1 Perform the Flash Upgrade

Note:
Makesure that Tekllnk Isnot running
beforeyou perform the Flash upgrade.

1. Openthe Flash program:

Windows3.x:

• In Program Manager,double-dick
on the TekLink programfolder and
then double-clickon the Flash
proqramicon (Figure 3.2.1.1.1).

~
Figure 3.2.1.1.1: I
Flash Program Icon

Windows95/98/NT:

Choose Start> Programs>Tekllnk.
Select the Flash program Icon
(Figure 3.2.1.1.1).

2 Select File> Configure Ports
(Figure 3.2.1.1.2).

Figure 3.2.1.1.2:
File> Configure Ports

3. In the ComPortSetupscreen
(Figure 3.2.1.1.3), type the Com
Portnumber the concentratorIs
connected to.

CamPan [] t:t

(!;;\~"I1j ~;~~!Il

Figure3.2.1.1.3: I
EnterCom PortNumber

4. ClickOK

5. Select File> Send Flash Image to
Instrument (Figure 3.2.1.1.4).

Figure3.2.1.1.4:
File> Send Flash Imageto Instrument

6. Select the ROM ImageFilefur­
nishedto you byTeledyne
Tekmar.The file will havethe
version namefollowed by the .bln
extension (Figure3.2.1.1.5).

Figure3.2.1.15:
Select Fileto Send

7. ClickOK

[Contlnued_J
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Figure3.2.1.1.8:
TekLlnk Help> About

Figure3.2.1.1.7:
Flash ProgrammingComplete

10. When Flash programming Is
successful, a status window wIH
appear (Figure 3.2.1.1.7).

11. If Flashprogramming Iscomplete,
with no errors, exlt out of the Flash
program, power down the concen­
trator, then power up the concen­
trator. Your concentrator should
now be updated with the new
ROM version.

12. Toverify the programming ofyour
ROM upgrade:

a) StartTekLink.

b) Select Help> AboutTekLink.

The concentrator firmware version
should correspond with the ROM

, version of the Flash upgrade (Figure
3.2.1.1.8).

8. Youwill seethe Flash Burning
Process In a newwindow (Figure
3.2.1.1.6).

• Stage reflects the current state for
each sector.

• Current Sector Isa progress
lridicator,

• Error Count Indicates the number
of errors encountered while trying
to communicate with the concen­
trator. After 3 errors,the Flash
program will abort.

• Verify Errors Indicates the number
of errors encountered while trying
to verify a sector on the concentra­
tor. After 3 errors,the Flash
program will abort.

9. If the Flash programs aborts, one of
three messageswill appear:

a) Connect Error

b) Lost Communication with
Instrument

c) Can't Program Current Sector

Check the TekLink port configuration to
verify the correct COMPort setup. If you
continue to encounter errors, please-call
the Teledyne Tekrnar Customer Sup­
port Center (1.800.874.2004;outside the
US/Canada:1.513.247.7000).
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• TheDraincontrol button Isonly actlv~ when an AQUATek 70 method
Isrunning and Isnot shown here,

,....-iJllItiiilil~1
Inltrvment Control OpeI1lUons:
• Step, Start, Auto. Hold,

Step Standby. St.pto
Bake, andRttet
Instrument

• VIew Temperature Zont
Status

• EdltM.thod
• Edit SChedul.

"ifJijt'~~iJ
Easy Acctll toFrequently·
uUdSystem Operations;
• St.p
• Start
• Auto
• Hold
• Drain
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~,~
• Dlspllyt Inllalled

Concentmor(s)
• Conftgure Ports
• ExltTtkUnk

Figur~ 3.2.2:
Tektlnk Control Screen

3.2.2 TekLink Control Screen

When you first run TekLink, the TekUnk
Control Screen (Figure 3.2.2)appears.
The Control Screen is the primary
Interface between the computer and
toncentrator/AQUATek 70 configura­
tion, instrument,setup, status, and
operation capabilities.
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8. Check the COM port number of
your computer.

9. Repeat steps 1-5. If the error
messageappears again, please call
the TeledyneTekmar Customer
Support Center at (800)874-2004
for further assistance.

Note:
A possible error may occur If the
f1ash.exe program (or any other
program that may be using the same
com port) Is running while configuring
the com ports In TekLink.If this occurs,
close the conflicting program and
continue with setup.

6. Click OKto close the RS232 Error
screen.

7. Make sure all COM port and
Instrument connections are secure.

If one of the COM ports Isnot respond­
Ing or Is unavailable,TekLink displays an
RS232 Error Message Screen.
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F1gur~ 3.23.1:
ComPortSetup

2. Type the name of the concentrator
you are Installing In the Unit Name
field (this can be any name).

3. Type the number (1-4) of the COM
port that the concentrator Is
connected to In the Com Port field.

4. Repeat steps 2-3 for each addi­
tional concentrator that Iscon­
nected to your Pc.

5. Click OKto return to the Control
Screen.

3-8

3.2.3 Configure COM Ports

Tekllnk must be configured to identify
each connected concentrator with Its
appropriate COM(communication)
port and must also designate a single
concentrator asactive before further
analysis settings can be made.

1. From the Control Screen,choose
Unit Control> Configure Ports
(Figure 3.2.3.1).

-------------_......_--_._----~-~~,,~,_... ..~ .. -
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Standby Flow

The Standby Flow option Indicates
whether or not the concentrator's
sample pathway Isswept with gas
during the Standby step.

All AlC Outputs

Usethis option to specify whether the
AlC Outputs are controlled or off.

3-9
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Agure 3.25:
Configure Instrument

Configuration Descriptions:

TekUnk allows you to specify the
Instrument configuration of any active
concentrator.

To access the Instrument Configura­
tions screen:

1. From the Control Screen,select
Setup> Configure Instrument.

2. Configure the concentrator by
selecting options specific to your
system configuration.

3. Click OKto return to the Control
Screenwhen you are finished.

3.2.5 Specify Configuration

After you have assigned a name and
have configured each connected
concentrator to a COM port on your PC,
you must specify one of them asthe
active unit.

You must specify an active unit In order
to send, receive,and/or schedule
methods. However, you can edit
methods without tying them to a
selected active unit.

1. From the Control Screen, select the
Unit Control menu.

The top portion of the Unit Control
menu lists each concentrator that Is
connected to the PC and configured In
TekLlnk.

2. Click on the name of the concen­
trator you want to run.

3. After you select the active unit,
click outside of the TekLinkscreen
to close the Unit Control menu.

4. To verify the name and status of
the designated active unit, observe
the Instrument Statuswindow of
the Control Screen (Figure 3.2.4.1);
so that the name of the selected
unit appears In the Control Screen
title bar (0), a check mark appears
next to the selected name In the
Unit Control menu (f)), and that
the Instrument Statuswindow.
displays status Information for the
active concentrator ($).

Fgure 3.2.4.1:
Active Concentrator Indicators

3.2.4 Designate Active
Concentrator

......
~................
•"...
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TrapRegion Type

The Trap Region option has three valid
values:

GCHandshaking

The GCHandshaking option specifies
GChandshaking characteristics.

• On-normally operates the GC's
port.

Off-operates the GCwith no
input or output signals between
the concentrator and the Gc.

....
"r-.,.....­.............,.......
r
",............
•..
•..
••••
~

••

.. These modes arenoravailable wlrhrheAOUATek
70configurar/on.

User GCType

If you have ordered an Interface cable,
the UserGCType Is provided with the
cable.If you have not ordered a cable,
you must know the characteristics of
the input and output signals traveling
to and from the GCto determine the
GC UserType.

ManualDrainMod.-

The drain valve allows the sample
glasswareto be emptied. When It Is
open, liquid and gas can be forced out
of the sample glassware into the drain
system and out the back panel drain.

SelfTestTime

The selfTestTime option allows you to
specify a SelfTestTime other than the
default.

Leak Check Mode-

The LeakCheck Mode option Isonly
accessible during Purge mode.

FeedPressurize Mode-

1=he vent allows sample gasto exit the
sample pathway through a front panel
vent. When It Isdosed, pressure builds
up In the sample pathway. This Is used
to set the feed pressure (It eliminates
Trap Pressure Control [TPq effects).

Ambient-the concentrator uses
the standard Internal trap at
ambient temperature.

TurboCool-the concentrator
operates at cryogenic tempera­
tures when the TurboCool unit
(optional) Is Installed.

Cryofocuslng Trap-the concentra­
tor operates at cryogenic tempera­
tures when the Cryofocuslng Trap
(optional) Is Installed.Thls option Is
only available when running a
6000 (with Internal cryo trap)
method.

•

•

•

GCType

You can configure the concentrator for
either a Standard or User type GCPort.
The GCtype classification Is based on
the input-output characteristics ofthe
GCas It Interacts with the concentrator.
Pleaserefer to your concentrator user
manual or I/O cable diagram for
detailed information on GCconfigura-
tion. .

":it'f' .' : ': ;.". :.;..".~~~ ';. >,' " "" " ,. ,. , .: ., . i')~~,.:,.!:
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3.3.1 Method Editor

To accessthe Method Editor (Figure
3.3.1),select Instrument> Edit Method
from the Control Screen.

Figure 33.1:
Method Editor

AQUATEK 70 LIQUID VIAL AUTOSAMPLER *1- USING TEKLINK AND PROCESSING SAMPLES
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3.3 Method Development

After you have Installed and conflg­
uredTekLlnk, you can create custom­
Ized methods (operating sequences)
for sample processing that meet your
analytical requirements.

After you connect the required
concentrator(s) and configure the
computer COM ports to recognize the
connected units, you can use the
Method Editor to review and edit
methods.
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Print Method From Disk

Select File> Print Method From Disk to
print out the parameter listing of a
method file.

Delete Method From Disk

Select File> Delete Method From Disk
to permanently remove a saved
method file from your hard drive.

Exit Method Editor

Select Ale> Exit Method Editor to exit
out of the Method Editor screen and
return to the Control screen.

Method Editor File Menu

The Filemenu (0, Figure 3.3.1)of the
Method Editor screen contains options
for loading, saving, printing, and
deleting method files.

Load Method From Disk

TekLinkcontains two default method
files for the concentrator with AQUATek
70. Select one to view and edit. All
method file names end with .mt3.

To load a method from the disk:

1. Fromthe Method Editor screen,
select File> Load Method From
Disk. Pleasenot that you cannot
load method files from previous
versions ofTekLink.

2. Selectthe method file you wantto
load.

3. ClickOKto return to the Method
Edltorscreen. All parameters will
reflect the values of the loaded
method. The current method file
name should now be visible In the
Method Editor title bar (G).

SaveMethod to Disk

Select File> SaveMethod to Disk to
savethe current method file.

SaveMethod As•••

Select File> SaveMethod As... to save
the current method configuration
under a new filename.

3-12
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Three columns (40, Figure 3.3.1) display
values that define time, temperature,
and other operational parameters for
the current method. If a parameter and
Its value are uneditable (grayed out or
not turned on), then the option
required is not installed on your system
or Is not accounted for In the Configure
Instrument screen.

Ifyou have system accessories (e.g.,
Cryo Focuser,20XX,or AQUATek 50)
connected to the concentrator, be sure
to turn them On In the Method Editor.

Notes Text Box

The Notes text box (0) permits you to
store up to 200 characters of text.
TekLink stores the Notes with the
Method File when saved.

MinIMax Field

The MinIMax field (G» displays the
minimum and maximum value setting
for each parameter when the cursor Is
placed within a parameter field. If the
value you enter In the Method Editor is
greater than the maximum or smaller
than the minimum values shown In the
MinIMax readout,TekLink displays an
error message.

To clear the error message:

1. Click OK.The parameter value
defaults to Its previous entry.

2. Enter a parameter value that Is
within the acceptable minImax
range.

At first power up, the concentrator Is
scheduled to run DEFAULT.MT3 which Is
an Invalid 3000/3100 ROM default
method. DEFAULT.MT3 does not really
exist, but appears In the Operation
Status window until a valid method Is
loaded and sent from the Schedule
Control. The concentrator automati­
cally performs self tests and remains In
Standby until all heaters and coolers
have reached their default temperature
setpolnts. When temperature setpolnts
are reached, the concentrator goes into
Purge Ready mode. At this point, you
can either create, change, or select a
method schedule.

A concentrator front panel default
method is Included with TekLink and Is
namedCONCENTR.MT3.

The methods named A7Q-Sml.mt3 and
A7o-25ml.mt3 are the default methods
specifically configured for the 30001
3100 with AQUATek70. The default
parameters are listed in Tables 3.3.1.1
and 3.3.1.2.

The defaults listed in the following
tables are guidelines; you may need to
edit certain values depending on your
analysis requirements.
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Method Parameter Value

line Temp 150°C

Valve Temp 1500
(

MountTemp 400
(

MCS line Temp 40°C
PurgeReadyTemp 300

(

PurgeTemp DoC

Turbo CoolTemp -20°C
SampleHeater Off
PrePurge Time 3 Min.

SamplePreheatTIme 5 Min.
SamplePreheatTemp 40°C

PurgeTIme 11.0 Min.
DryPurgeTime 0.0Min.
GC StartOption Startof Desorb

GC Cycle Time 0.0Min.

Cryo Focuser Off
DesorbPreheatTemp 245°C

DesorbTime 4.0Min.

DesorbTemp 250°C
SampleDrain On

Bake Time 10.0 Min.
Bake Temp 2600

(

Bake Gas Bypass Off

MCS Bake Temp 300°C
PressurizeTime 1.05 Min.
Fill IS _ On
Fill ISTIme · 0.04Min.

PrimeIS · 0.1 Min.
Transfer SampleTime 0.75 Min.

Rinse lines Time 0.75 Min.
Purgelines Time 1.25 Min.
Bake Rinse Time 0.75 Min.

Bake TransferTime 1.0Min.
Bake Rinses 2 Rinses

Table33.1.2:
Default Method Parameter Values for A70_2Sml:mt3
(AQUATek 70 usIng2SmL Sample Loop)

Method Pclrametcr Value

line Temp 1500
(

Valve Temp 1500
(

Mount Temp 400
(

MCS line Temp 40°C

Purge ReadyTemp 300
(

Purge Temp OO(

Turbo (001 Temp -200
(

SampleHeater Off

PrePurge Time 3 Min.

Sample PreheatTlme 5 Min.
SamplePreheatTemp 40°C
Purge TIme , 11.0 Min.

DryPurgeTIme 0.0Min.
G( Start Option Start of Desorb
G( Cycle TIme 0.0Min.

CryoFocuser Off
DesorbPreheatTemp 245°(

DesorbTime 4.0Min.

DesorbTemp 250°C
Sample Drain On
BakeTime 10.0 Min.

BakeTemp 260°C

Bake Gas Bypass .., Off
M(S Bake Temp 300°C

Pressurize TIme 0.20Min.
Fill IS On

Fill IS Time 0.04Min.
Prime IS 0.1 Min.
Transfer SampleTime 0.50 Min.

Rinse lInesTlme 0.25 Min.
Purge lInesTIme 0.25 Min.
Bake Rinse Time _ 0.75 Min.

BakeTransferTime 1.0Min.
Bake Rinses _ 2 Rinses

Table 33.1.1:
Default Method Parameter Values for A70_Sml.mt3
(AQUATek 70 using Sml S&mple Loop)

3-14
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AQUATek 70 Mode Descriptions

AQUATek 70 steps through several modes
during a sample run.

Standby

Standby Is the main preparatory step for
each run and establishes initialconditions
on power up, restart, or after a run. When
the concentrator powers up or returns to
Its starting conditions after a run, this step
Isactive. Press Start to begin a run.

Purge Ready

The concentrator walts for a start signal
from the user (via the Start button In
TekUnk) or from an accessory before pro­
ceeding to the next step.The Purge Ready
screen displays the message"Press start to
begin" and the number of the current
method.

Pressurize

The sample vial Is pressurized and the
sample loop is filled with sample from the
sample vial.

Fill liS

The Internal standard valve rotor Is filled
with internal standard.

Transfer Sampl.

The Internal standard and sample are trans­
ferred from the sample loop to the concen­
trator frlt sparger.

Rinse Lines

The sample loop,line to the sample needle,
and the sample needle are rinsed with hot
water.

PurgeUnes

The sample loop,line to the sample needle,
and the sample needle are flushed with
clean helium or nitrogen gas.

---,--,------

Purge

The sample Isflushed with pllrge gas for a
specified length of time.

Dry Purge

Dry gas sweeps through the concentrator
trap to remove moisture.

DesorbR••dy

During this step,the concentrator walts for
the GCReady signal.

Desorb

The contents of the trap are flushed onto
the GC column; sample loop, line to the
concentrator, and the concentrator glass­
ware are rinsed with hot water.

B.keRlns.

The sample loop and the line to the con­
centratorare rinsed with hot water;the con­
centrator glassware Isthen rinsed and fllled
with hot water.

Bake Transfer

The sample loop, line to the concentrator,
and the concentratorare flushed wfthdean
helium or nitrogen gas.

BakeSwHp

Clean gas Issentthrough the linesand trap
to remove residual moisture and organic
contaminants.

Bake

The MCS and the concentrator trap heat­
ers heat up to Baketemperatures.The con­
centrator Sample Bypass and DrainValves
are ON.TheConcentratorVentValve isOFF.
Clean gas Is sent through the system to
sweep residual moisture and organic con­
taminants from the lines.Tocheckthe con­
centrator system flow during Bake mode
while running an AQUATek method, place
the flowmeter outside the Drainport ofthe
concentrator.

3-15
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Figure 3.4.1:
Schedule Control
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You can use the Schedule Control
screen to set up a method schedule, or
processing timetable, for running
samples. When you use the concentra­
tor without an autosampler, you
specify the number and sequence of
methods to be run on a single sample.

When you use the concentrator with
one or more autosamplers, you set up a
method schedule that defines:

• The method(s) to be run.

Start and stop positions for each
method.

• A sequential order for each sample
to be run.

You must use the Schedule Control
screen to set up a schedule,even If you
are running a front-panel sample
position with the concentrator;

You can enter any desired method
schedule and send It to the selected
concentrator within the Schedule
Control screen.

3.4 Create Method Schedule

After you create customized methods,
you can define a method schedule that
specifies samples,operating sequences,
and the order in which they will run.

To access the Schedule Control screen
(Figure 3.4.1), select Instrument> Edit
Schedule from the Control Screen.

The Schedule Controlscreen has four
columns and 12 rows for creating up to
12 method schedules.



Send Schedule

The Send button (0) sends the current
displayed schedule tothe active
concentrator.

OK Schedule

The OKbutton exits the Schedule
Control screen and returns to the
Control Screen. Youwill not be
prompted to send the current schedule
If It haschanged or If you have not
already sent It to the concentrator.

Print Schedule

Press the Print button In the Schedule
Control window to send the current
schedule Information to the default
printer.

Schedule Control Help

The Help button accesses online help
Information about the Schedule
Control screen.

Delete Schedule Line

Press the Delete button In the Schedule
Control window to delete the line In the
current schedule. Make sure that you
place the cursor somewhere In the line
to be deleted.

AQUATEK 70 LIQUID VIAL AUTOSAMPLER i\!- USING TEKlINK ANDPROCESSING SAMPLES

Method Display and
Method Selection

Click the Method selection button (4D)
to select the filename of the method
you want to schedule. The filename of
the method you select will then appear
in the method display field (0).

Start and Stop

Enter the vial position number of the
first sample In the Start field (0, Figure
3.4.1)and the vial position number of
the last sample in the Stop field ($) to
be run according to the specified
method. The default sample start and
stop positions are both 0, the number
assigned to the front-panel sample on
the concentrator unit.

RPS (Runs Per Sample)

This value (4D) Isunalterablewhen
scheduling an AQUATek 70 method and
remains at 1 RPS.You may Increase the
RPS value when scheduling concentra­
tor only methods.

3-17

MinIMax

The Min/Max status field (CD) at the .
bottom of the Schedule Control screen
displays the minimum and maximum
autosampler vial positions for the
selected method. When a schedule Is
sent and the concentrator acknowl­
edges receipt of the schedule, this field
dlplays the words Schedule Sent.
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3.4.1. Schedule a Sample Run

1. Clickthe Method button In the Note:
Schedule Control screen (see Figure

Selecting the OK button will not send3.4.1).
your schedule to the concentrator and

2. Loadthe file of the method you want will not save the schedule you have
to run. edited.You must selectthe send button

3. ClickOK to return to the Schedule In the Schedule Control to run the

Control screen. If the method file schedule.Theschedule has beensuccess-

you loadedIsIncorrect, clickthe fully sentto the concentratorwhen the

Method button again In the Sched- bottom of the Schedule Controlscreen

ule Control screen and selectthe reads'Schaduls Sent~

correct file. 10. Click Printto print the current
4. Position the cursoron the Startfield. schedule, or OKto return to the

Control Screen.
5. Typethe position number of the first

After sending a method schedule to thesamplevial to be run accordingto Its
method. activeconcentrator, the OperationStatus

window of the Control Screen displays
6. PosItion the cursoron the Stopfield. the current statusInformatIonfor the
7. Type the posItion number of the last activeconcentrator:currentmode,

samplevial to be run accordingto Its sample position,and method filename.
method. If you enter an out-of-range Theactiveconcentratorwill remainIn
samplevial position value, anerror Standby until the concentratorreaches
messagewlll appear. It IsImportant temperaturesetpolnts. When setpolnts
that you first select the method and are reached, the activeconcentrator will
then enter the start and stop step to Purge Ready. You maybegin
positions. If you enter a position running samples at this time by clicking
number that Isout-of-range,the the Startbutton In the ControlScreen.
error will occur when TekLink begins

If you wantto checkon the statusoftheto run the scheduledmethod with
the out-of-range position. temperaturezones (Figure 3.4.1.1), select

Instrument> TempZoneStatus from the
8. Verifythat the RPS (runsper sample) ControlScreen.

valueIs1.

9. Clickthe Send button to transmit the
current method schedule and
required filesto the activeconcentra- .: :;':. ,.~.

tor.

FIgure 3.4.1.1:
Temperature ZoneStatus

------------··--·-•• - .•--~~._.~..w_w. .~_~
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Prime ISand H
20

An AQUATek 70 method must be active
(active InTekLinkand sent to the concen­
trator) In order to prime the ISand H

20
lines.

If you have AQUATek 70 connected to
your concentrator, you may prime the IS
and/or the H

2
0 lines before running

samples. These procedures should be
performed each time either the ISor H

2
0

Ischanged.

1. In Tekllnk, select Setup> Prime In­
ternal Standard from the Control
Screen.

. 2. Click OKat the screen prompt to Ini­
tialize the Prime ISrequest.

3. SelectSetup> Prime H20 Linesfrom
the Control Screen.

4. Click OKat the screen prompt to Ini-
tialize the Prime H20 Lines request.

The systemsteps through four operating
modes during Prime ISbefore returning
to Standby:Prime IS,Prime ISRinse,Prime
ISTransfer, and Abort Bake

The systemsteps through two operating
modes during Prime H20 Lines before
returning to Standby: Prime H20 Rinse
and Prime H

2
0 Purge.

AQUATEK 70 LIQUID VIAL AUTOSAMPLER ~l~ USING TEKLINK ANDPROCESSING SAMPLES
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Before you begin to run samples with
AQUATek 70,you need to: load sample
vials In the autosampler rackts), prime
the Internal standard (IS), and prime the
water (H20) lines.

3.5 Sample Setup

,.,.,. , '..,'0· ,
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3.6.1 Initiate Sample Run

Click the Start button or select Instru­
ment >Start tobegln the sample run.

The concentrator will proceed to the
first operating step In the scheduled
method.

3.6 Run Samples

Figure 3.6.1:Control Buttons

Step

Click (O, Figure 3.6.1)to move the
concentrator to the next operating step
during the sample run.

Start

Click (f)tolnltlate the sample run.

Auto

Click (e) to resume the normal
operation after the concentrator has
been In Hold.

Hold

Click (O) to pause.the concentrator.To
resume operation, click Auto.

Drain

Click (e) to empty the contents of the
concentrator sparge vessel.

3-20
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Step to Standby

From the Control Screen,select Instru­
ment > Step Standby.

A warning screen wIll ask you whether
or not you want to step the concentra­
tor to Standby. If you select Yes, the
current sample and schedule will be
aborted.

Step to Sake

From the Control Screen,select Instru­
ment > Step to Bake.

A warning screen wIll ask you whether
or not you want to step the concentra­
tor to Bake.If you select Yes, the current
sample and schedule will be aborted.

Reset the Concentrator

From the Control Screen,select Instru­
ment > ResetInstrument.

A warning screen will ask you whether
or not you want to reset the Instrument.
If you select Yes, the concentrator will:

• abort the current run and schedule

• perform Its self tests

• hold In Standby

Drain

The Drain control button Isactive only
when an AQUATek 70 method-Is
running.

Click the Drain control button to empty
the concentrator sparge vessel during
an AQUATek 70 method run.

Step

Click the Step button to advance
through the operation steps (or modes)
of an operating sequence.

Step ends the current operating step
and moves the concentrator to the next
operating step ofthe current method.

3.6.2 Sample Run Alteration

AQUATEK 70LIQUID VIAL AUTOSAMPLER ~* USING TEKLINK ANDPROCESSING SAMPLES

Auto

Click the Auto button to take the active
concentrator out of Hold and to resume
the normal step progression.

At times, you may find It necessary to
Interrupt, change, and/or abort the
normal operating sequence of a sample
run In progress.

Hold

Click the Hold button to stop the
concentrator from advancing to the
next operating step.

While the system Is In Hold:

• The Operation Status window of the
Control Screen shows that the status
of the active concentrator Is In Hold.

• The dynamic timer continues to
progress, allowing you to monitor the
duration of a specific operating step.

• If the timer times out, the concentra­
tor will remain In the current operat­
Ing step until the Auto button Is
selected.

-----------------...------------
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Abort Current Sample

Select Abort Current Sample to abort
the sample In progress.The active
concentrator will then proceed to the
next scheduled sample.

Selecting Abort Current Sample will
step the concentrator to Bakefor 95
minutes and will drain the contents of
the concentrator sparge vessel.

Rerun Sample

Select Rerun Sample to abort and rerun
the current sample.

Complete Sample and Abort

Select Complete Sample and Abort to
finish running the current sample and
to abort the rest of the schedule. The
active concentrator will finish the
sample that is running and return to
beginning of the schedule, and go to
Standby.

Figure 3.6.2.1:
AbortSchedule/SampleScreen

Abort Schedule and/or Sample

Toabort a schedule and/or sample run
that IsIn progress, select Setup> Abort
Schedule/Sample from the Control
Screen (Figure 3.6.2.1).

Abort Entire Schedule

Select Abort Entire Schedule to abort
the entire schedule/sample In progress.
The active concentrator will return to
Standby for the first scheduled method.

Selecting Abort EntireSchedule will
step the concentrator to Bakefor 9.5
minutes and will drain the contents of
the concentrator sparge vessel.
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3.7 Sample Run Checklist

Please refer to this checklist before
starting sample runs until you feel
confident operating AQUATek 70.

1. Start TekLink (§ 3.1.4).

2. Load or create new Method file(s)
in the TekUnk Method Editor
(Instrument> Edit Method).
SaveMethod file and exit Method
Editor (§ 3.3).

3. Usethe schedule worksheet
(§3.7.1) to help you to define your
schedule,create a Method Sched­
ule (§ 3.4), and Sendthe Schedule
to the concentrator

4. Prepareand load the samples onto
the autosampler vial rack using
your schedule worksheet asa
guide.

5. Prime the Sample Module IS(§35).

6. Prime the Sample Module H
2
0

(§35).

7. Click the Start button (§3.6.1) to
initiate the sample run.

You can monitor the process ofyour
sample run by looking at the Operation
Status window (§3.2.2) of the Tekllnk
Control Screen.

If you encounter any difficulties during
operation, please refer to the
Troubleshooting sections In Chapter 4.

~---------,_ .._--_.._--------------------,--
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3.7.1 Method Schedule Worksheet

Make copies of this schedule worksheet to keep handy when you create new
method schedules. More worksheets are available on the following pages.
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4.1.2 Safety Considerations

4-3

AQUATEK 70LIQUID VIAL AUTOSAMPLER ~l~ MAINTENANCE ANDTROUBLESHOOTING

4.1 Before you Begin

4.1.1 Recommended Tools

--",-,------------------------

r ',";','·,·

Safety glasses • Switch off electrical supplies

• Tubing cutters before working onInstruments.

Grounding strap
~

Wear safetyglasses.

Small, Large Phillips head screw-
drivers

&> Toavoidelectricalshock, turn
Small,Medium,Large slotted off and unplug the sample
screwdrivers module, autosampler, and

5/16" nut driver concentratorbeforeremoving
anyexterior panels.

• 1/4",7/16", 9/16",3/4"open-end
wrenches &> Do not placeliquids nearthe
Allenwrench set area where you areservicing

E
the unit. Liquidscanconduct
electricity If they comeIn
contact with circuits.

• @\ Do not redesign or modify the
equipment In anyway. Do not

& remove equipment grounds.
Never replace a fusewith one
of a higher rating.Always use
the correct replacement parts.
Failure to follow theseguide-
lineswill void your warranty.

£ Internalparts (especially
heaters and electronic compo-
nents) canget extremelyhot.
When maintaining or trouble-
shooting,be carefulnot to
touch theseparts.Allow parts
to cool before replacingthem.

~
Do not exceed the maximum
pressure ratings.

,... " .." ' "." J'~ L" "'."J'f,~,'~ "'
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Refill and Replace Internal
Standard

See Section 2.7.9In Chapter 2.

4.2

Turn off the power supply to all
units before performing any
type of maintenanceor
troubleshooting procedure.

Power down the sample module,
autosampler,and concentrator.

Unplug the power cord from the
sample module.

3. Remove the two thumbscrews from
the right side panel CO, Figure 4.2.1)
of the sample module and set aside.

2.

•

Figure 4.2.1 Access Sample ModuleInterior

4.1.3 Sample Module Cover
Removal

4. Remove the four Phillips screws from
the left side panel ce) of the sample
module and set aside.

5. Shift the sample module slightly to
the left so that the autosampler arm
Is not above It.

6. Remove the sample module cover
ce) by lifting It straight up.

7. Set the cover aside.

8. Perform maintenance or trouble­
shooting procedure and then reverse
steps 1-6 to replace the cover.

4-4



7. When there Isenough clearance,
11ft the electronics/plumbing
divider straight out of the unit.

8. Unsnap the valve control board (0)
from the 4 Pem studs located in
each corner.

9. Raise the valve control board just
enough to access and disconnect
all connectors. All connection
wires are marked with a shrink­
wrapped label. You may also refer
to the wiring diagram In the
Diagrams section for more details.

10. While holding the valve wires out
of the way with one hand,snap the
new valve control board onto the 4
Pem studs.

11. Placethe valve wires back Into the
corner of the electronics area.

12. Guide the electronics/plumbing
divider back In and over the
electronics area being careful to
enclose all wires within It the cover
being careful not to pinch any of
the valve wires with the edges of
the electronics/plumbing divider.

13. Screw the nut and lockwasher back
on to secure the cover. Becareful
not to pinch any of the valve wires
or tubing with the edges of the
electronics/plumbing divider.

TeledyneTekmar advisesthat
you weara grounding strap to
discharge staticwhen access­
Ingthe electronics area ofany

. Instrumentation.

A
•
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4.3 Valve Control Board
Replacement

1. Power down the sample module,
autosampler, and concentrator.

2. Unplug the power cord from the
sample module.

3. Remove the sample module
chassis cover.

4. Remove the clear, plastic electron­
ics/plumbing divider (0, Figure
4.3.1):

5. Usea 5/16"nut wrench to remove
the nut and lockwasher (f)) that
attach the electronics/
plumblngdlvlder to the rear panel.
Thenut and lockwasher are
located directly beneath the power
entry module ($).

6. .liftthe electronics/plumbing
divider out by sliding the left side
of the cover forward (past the
power entry module and Its
connectors.

-•



4.4 Fuse Replacement

Agure4.4.1
Locatfon of Power En Module FuseDrawer
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Replace PowerSupply Fuse

1. Powerdown the sample module,
autosampler,and concentrator.

2. Unplug the power cord from the
sample module.

3. Removethe electronics/plumbIng
dIvider.

4. Carefully remove the 1A 250V
standard fuse (0, FIgure4.4.2) from
the power supply (&) located at
location FS1.

5. Discardthe affected fuse.

6. Replace wIth same ratIng fuse.

7. Replace the electronics/plumbIng
divider and chassIs cover,

Turn off the powersupply to all
unitsbefore performing any
typeof maintenance or
troubleshooting procedure.

Replace PowerEntry Module Fuse

1. Insert a small slotted screwdrIver
up and through the bottom
openIng (0, FIgure4.4.1) ofthe
power entry module (thIs was
exposed when the power cord was

.removed).

2. Gently push the fuse holder out
from the module.

3. Removethe affected (1 A 250V)
fuse and discard.

4. Replace wIth the same ratIng (1 A
250V)fuse.

5. Snapthe fuse holder back Into the
power entry module. The triangles
on the module should fIt together.

•



Figure 4.5.1 Power Supply LocatIon

---'-------------------------

1. Power down the sample module, 8. Unsnap the right side of the power
autosampler, and concentrator. supply from the two Pem studs.

2. Unplug the power cord from the 9. Disconnect the electrical connec-
sample module. tlons from the power supply.

3. Turn water and gas supplies off. 10. Carefully 11ft the power supply out

4. Remove the sample module and discard.

chassiscover. You must access the 11. Place the left side of the new
back of the sample module to power supply over the standoffs
replace the power supply. If and snap the right side of the
necessary,disconnect the water power supply onto the two Pem
and gas lines from the unit for studs.
better access.

12. Insert the two screws through the
5. Remove the electronics/plumbing holes on the left side of the power

divider. supply and screw Into the stand-

6. Disconnect the cables from the offs.

bottom of the valve control board 13. Reconnect the all connectors to
(0, Figure 45.1). the power supply.

7. Usea small, slotted screwdriver to 14. Reconnect all cables to the valve
remove the two #4x32 1/2"pan control board.
head screws from the left side of

15. Replacethe electronics/plumbing
the power supply (4D) and set aside.

divider and chassiscover.

4-7

Turn off the power supply to all
units before performing any
type of maintenance or
troubleshooting procedure.
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Power Supply
Replacement

4.5
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6. Disconnect the electrical connec­
tions (f) from the affected valve.

7. Removethe two #4 flathead screws
from the right exterior panel ofthe
sample module that secure the
valve and set aside.

8. Removeand discard the affected
valve.

9. Reverse steps 1-8 to Install the new
valve.

Turn off the power supply to all
units before performing any
type of maintenance or
troubleshooting procedure.

Solenoid Valve
Replacement

4.5

1. Turn water and gas supplies off.

2 Power down the sample module,
autosampler, and concentrator.

3. Unplug the power cord from the
sample module.

4. Removethe sample module
chassis cover.

5. Disconnect all tubing connections
(0, Figure 45.1) from the affected
valve and place the tubing out of
your way.

•
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Figure4.6.2 Pressur@ S@nsor Switch Assembly

7. Disconnect the 118"water pressure
line fitting (0, Figure 4.6.2) with a
7116"wrench.

Note:
Thepressure switch isfactory-set to
60psl. Do not alter thissetting.

8. Disconnect all electrical connectors
($).

9. Remove the #6-32 hexnut (fD, top
of pressure switch plateand 1"nut
standoff) witha 5/16" nut driver
and set the nut and lock washer
aside.

10. Remove and discard the pressure
switch assembly.

11. Reverse steps 1-10to Install the
new pressureswitch assembly.

AQUATEK 70LIQUID VIAL AUTOSAMPLE!t '* MAINTENANCE ANDTROUBLESHOOTING

Turn off the power supply to all
units before performing any
type of maintenance or
troubleshooting procedure.

Pressure Switch
Replacement

......'.' '..,'..' ,...- ·,'·"',··,··',.,'".,', ' '.•.,.,,w,••"..,."•••..•.w-------.' ~-___:~'. o(__" ', .-..v. «.-.._,_ _.'.',-,

Figure 4.6.1 Pressur@ Sensor Switch Location

1. Turn waterand gas supplies off.

2. Disconnect the watersupply.

3. Power down the samplemodule,
autosampler, and concentrator.

4. Unplug the powercordfrom the
samplemodule.

5. Remove the sample module
chassis cover.

6. Locate the pressure switch assem­
bly(0, Figure 4.6.1).

4.6
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Figure 4.7.1 Sample Loop

4.7 Sample Loop
Replacement
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6. Dlsconnectthe1/S"tublngflttlng
that connects the other end of the
sample loop to the drain valve (4D).

7. Remove sample loop and discard.

S. Connect the fitting on each end of
the sample loop to the sample and
drain valves.

Turn off the power supply to all
units before performing any
type of maintenance or
troubleshooting procedure.

1. Turn water and gassupplies off.

2 Powerdown the sample module,
autosampler, and concentrator.

3. Unplug the power cord from the
sample module.

4. Remove the sample module
chassis cover.

5. Disconnect the 1lSI/tubing fitting
that connects the one end of the
sample loop (0, Figure 4.7.1)to the
sample valve (e).

•
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4.8 Hot Water Tank
Replacement

Electrical hazard. Use extreme
caution when performing this
procedure.Turn off and unplug
power cords from all electric
components.

Water supply must be turned
off.

Water In tank maybevery hot,
Allow time for tank to cool
before replacing the tank.

1. Powerdown the sample module,
autosampler, and concentrator.

2. Unplug the power cord from the
sample module. All power must be
disconnected.

3. Turn water and gas supplies off.
4. Removethe sample module

chassis cover.
5. Disconnect the 4-wlre connector

(0, Figure 4.8.1)from the top of the
temperature sensorboard located
on top of the hot water tank.

FIgure 4.8.1 HotWater Tank Assembly.Top

6. Removethe two 5/16"nuts and
lockwashers (ft, not shown) from
each side of the metal bracket with
a 5/16" nut driver.

7. The tank may be full of water and
must be emptied. Disconnect the
water line (0) that leads to the rear
of the unit and place Into a drain
container (large enough to hold at
least 70mL).

8. Disconnect the 1/8"brass nut (0)
from the brass elbow fitting on top
of the heater.The contents of the
tank will drain Into the drain
container.

9. After the tank drains entirely of
water, disconnect the 1/8" brassnut
from the bottom ofthe tank (0,
Figure 4.8.2).

10. Disconnect the connectors from
the pressure sensor switch (e).

11. Disconnect the J11 connector from
the valve control board.

12. Disconnect the grounding wire
from the bottom of the tank (0) by
removing the one #4 screw,

13. Detach the metal bracket (0) from
the hot water tank.

14. Remove and discard the affected
hot water tank.

15. Reverse steps 1-14 to Install the
new hot water tank assembly.

4-11
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4.9 Pressure Regulator
Assembly Replacement
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Turnoff the power supply to all
units before performing any
type of maintenance or
troubleshooting procedure.

4-12

1. Power down the sample module,
autosampler, andconcentrator.

2. Unplugthe power cordfrom the
sample module.

3. Turn waterand gassupplies off.

4. Remove the samplemodule
chassis cover.

5. UsIng a 1116"Allenwrench, loosen
the setscrewon the knurled
pressure regulator control knob (0,
Figure 4.9.1) on the front of the
sample module.Remove the knob
and setaside.

6. Detach the three 5/16"brass nuts
from the backof the pressure
regulator(0, Figure 4.9.2).

7. Using a3/4" wrench,remove the
nut on the front of the pressure
regulator(., Figure 4.9.1) and set
aside.

8. Remove the pressure regulator
assembly (., Figure 4.9.2) from the
sample module.

9. Reverse steps1-8to Install the new
pressure regulator assembly.

•
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• ClickOKto dost the trror ween. Tht
Method plramettr values rttum to
thtlr dellllits.

4-13

• Checkthlt IIIStart and Stop viii
positiOnsentered Irt correct In the
SChedult tor the methods you Irt
running.

• Re-send the Schedult to the
concentrator.

• Check that tht Method and Schedul.
Irt Ipproprilte tortht type otsysttm
configuration you Irt running.

• Confirm units Irt properly connected.

• CpnflrmthltTtkUnkrteogn~tsthe

configuration.
• AQUATtk 70 IsON (orOFFIf running I

single-position method) In th.
M4Ithod EditorsaNn.

• SIV. Mtthod.
• VtrIty or edit th. Schedultand s.nd

to the concentrator.

User Interface errors flag discrepancies
between what the operator has
configured the concentrator to do and
what the system Iscapable of doing.

User Interface Errors

On. or mort ot the linesIn tht
SChedult sent hive In Invilid Start or
Stop viii position valu••

this ustr Intertlce trror Indlcltes that
your method Schedule IsIncorrecttor
tht plrtlcular unit configuration you
Irt running. For tXlmple, tht trror
wlllippeirfl you Irt trylng to run In
AQUATtk 70 IImplt on position 0
or I front-panel concentrltor IImple
on position 10.This Isbecause 0
Indlcltts I single-position, tront­
plntl unit Ind I numbtr higher thlt
o Indlcltes I multiposition unit,

such IS tht AQUATek 70 system.
think ot this error IS IImple type
mismatch •

this ustr Interflct trror Indlatts that
I valut you hlvt tnttred tor I
plrtlcullr pAramettr Isout ot Its
IlIowlblt rlngt. Tht Mtthod Editor
screen shows tht minimum and
maximum vlluts torthlt plrlmeter
In tht MIn/MIX fltld.

Slmplt/Mtthod
Mlstnlltch

Schedult Empty

Table 4.10.1 User InterfaceErrorCodes

4.10 Error Messages

The following tables describe error
messagesyou may encounter when
operating the AQUATek 70 system and
the action you should take Ifyou
encounter them.
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,3• TIghten the sensor board screw.

If error persists, then

• Replace temperature sensor board.

• Reset the concentrator.

• Watch progress of system Inltl.llzatlon Ind self·
tests.

• R.sume ope ...tlons.

• TIghten the sensor board saew.
If error persists, then

• Replace tempe...ture sensor board.
Iferror persists, then

• Replac. hot water tank.

• Reset the concentrator.

• Watch progress of system Initialization and self·
tests.

• Resume op....tlons.

• Chtck that the SIImplemodule and
autohmpler both hive power.

• Both are properly connected,

• TekUnk rtcognlzes them.

• AQUATek 70 IsON In the M.thod EdItor scrHn.

• Sav. the Method.
• Verify or edit the Schedule and Mnd to the

concentrator.

• Check physical condItion of hllter In the
concentrator (blown trI,C on the power
supply/output bOlrd, eltctrlcal short, open or

• bid thermocouples. conftrm III wiring IsIntact).

• Repllr IS ntcessary.

• Reset the concentrator.

• W.tch progress of system Inltl.llntlon and self­
tests.

• Resume operations.

Please calltheTeledyneTeI<mar
Customer SupportCenter at (800) 874­
2004 or (513) 247-7000 If
troubleshooting efforts fall or If you
needfurther technical assistance.

This error signals I runlwlY
sltultlon, where a region In the
concentr.tor has exceeded Its
maxImum Slfe temperature
(such IS the transfer line or trap
region). This type of error will
shut down the system.

The base temperlture of the hot
water tlnk InsIde the sample
module does not ruch
temperature. The sensor board
screw on top of the hot water
tank may be loose or the
temperature sensor board may
need replacement

The stcondarytemperature of
the hot wlter tlnk Inside the
hmple module does not reach
Its setpolnt after 20 minutes. The
temperature sensor board screw
on top of the hot water t.nk may
be loose, the sensor board may
need replacement, or the hot
w.ter tank assembly may need
replacement

]i~'il,fiiMf,i¥)Wir !\tcWr# l"~~olijro.,,
The lutoSlimpler met • Res.t the ccncentrator, lutoSlimpler. Ind
Interference and did not perform hmple module.
I command or function. • Witch progress of system Inltlllizatlon and self-

tests.

• Resume operations.
Theautosampler Is not

. responding to I TekUnk
command or function. An
AQUATek method may be
loaded InTekLlnkwhen running
the concentrator without the
AQUATek syst.m Installed or
contlgured properly.

Maximum Fall..le
bceededon
Heater [Nlme)

A70 Sensor I!rror

A70A$MNot
Responding

A70 Heater Error

Table 4.10.2 Operation Error Codes [contlnued._l

Operation Errors

OperationerrorsIndicate problems
with a mechanical or electronic system
within the concentrator,sample
module,or autosampler.

--_......_------_.----,-~-_.,,-,---~,-----



Table4.10.2 Operation Error Codes
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Minimum F.nAfe This error Indicates thlt I r~on o Check physicil condition of helter and
Ixc..d.clon (such IS the trap region) of t e electronics In the concentrltor (thermocouple
He.ter [Name] concentrator Isnearln~ Ind helter connections, solid state reilY,Ind

temperlture Sltpolnt low thlt fuses).
which IsIllowed. Itcould Iiso

o Confirm all wlrlng Is Intact.
occur If the concentrator
e,.ctronlcs sends back I 0 Repllr IS necessary.
temperlture Sltpolnt thlt Isfir 0 Reset the concentrator.
below theallowlbre rlnge. o Witch progress of system Inltlallzltlon and self-

tests.
0 Resume operations.

No Repon.. from TekUnkIsunlble to 0 Make sure thlt the COMport configuration Is
Unit communlClte with the set up correctly InTekUnk.

concentnltor. 0 R.send the schedule to the concentrator.

Open Thiserror Indicates thlt a 0 Reconnect the thermocouple to the bolrd In
Thermocouple on thermocouple Isnot properly the concentrator.
He.ter [NIIme] connected or Isbid. Iterror pem.ts, then

0 Install an extension to ITIIke the proper
connections.
Iterror persists, then

o Replace the thermocouple It It Is bad.
o Repelr .. necessary.

o Reset the concentrator.
o Watch progress of system Inltllllzatlon Ind Hft-

tests.
0 Resume operatlonl.

Power'an This error Indicates thlt the o Check that the concentrator power cord Is
concentnltor either lost power or properly connected and that the power source
that Its power supply/output Isgood.
board Isbad Iterror persists, then

0 Replace the concentrator power supply/output
board.

o Reset the concentrator.
o Watch progress of system Inltlllization .nd .elt-

testl.
0 Resume operations.

Self-Test Failure Thedisplayed heater did not o Check physlcal condition of electronics, heater
on Heater [N.Ime) pass self-test connections and resistance, fuses In both the

concentrator and nmple module, .nd
thermocouple volt.ge Inthe concentrator.

0 Repair .. necflSlry.
0 Reset the concentrator.
o Watch progress of system Inltlllization and self-

tests.
0 Resume operatJonl.

Setpolnt Not Thiserror appelrs anytime thlt o Check physlcel condition of electronics, helter
Reechedon the concentrator does not reach connections .nd reslstlnce, and thermocouple
He.ter [NIIme] a particular setpolnt In the yoltageln the concentrator.

appropriate time. 0 Repair IS necesMry.
0 Reset the concentrator.
o Watch progress of system Inltlallz.tlon .nd selt·

tests.
0 Resume operltlons.

SyatemRe..t Thiserror Ippelrs anytime thlt o Reset the concentrator.
you hit Reset,on the o Witch progress of system InitializationInd selt·
concentrator, atter I hit-I error. tesu.

0 Resume operltlons.



Programming Errors
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• ClickOKto close the error KrMn. Th.

M.thod paramet... values r'turn to
their d.faults.

• Check thlt the M.thod and Schedul.
Ir. approprlat.for the type ofsyst.m
conflguRltlon you Ir. running.

• Conflrm units Ir. properly connected.

• Confirm that TtkUnk recognlz•• the
conflgur.tlon. '

• AQUAT.k 70 IsON (or OFFIf running I
slngl.posltlon method) In the
Method EditorKrHn.

• Save M.thod.
• V.rlfy or edit the Schedul. and aend

to the concentrator.

• Check that III Start Ind Stop vtal
positions .nt...ed Ire correct In the
SChedul. for the method. you Ir.
running.

• R.send the Schedul. to the
concentrator,

If you encounter a programming error,
please call the TeledyneTeIonar
Customer Support Centerat (800) 874­
2004or (513) 247-7000.If possible, jot
down exactlywhat you were doing
when the error occurred,and report
that Information.

~t~\:

This us... lnt.rface error Indicates that
a valu. you have .nt.red for a
particular parlmet.r Isout of Its
allowabl. rlnge. Th. Method Editor
scrMn shows the minimum Ind
maximum valu•• for thlt parlmeter
In the MIn/MaxfI.ld.

This us... lnt.rflce ...ror Indicates that
your method SCheduleIsIncorrect for
the particular unit conflgur1ltlonyou
Ire running. For,xlmple, the error
willap~lr fIyou Ir. trying to run In
AQUAT.k 70 Slmpl. on position 0
or a front·pan.1 eeneentrator Simple
on position 10.This Isbecause 0
Indicates I slng'.posltlon, front­
pan.1 unit Ind a number higher thlt
o Indicates I rnultlposltlon unit,

such as the AQUAT.k 70 syst.m.
Think of this error IS IImple type
mismatch.

One or mor. of the lines In the
Schedule sent have In InvalidStart or
Stop viii position valu•.

S.mpl./M.thocl
Mltmltch

5chedul.lmpty

Programming errors Indicate problems
withTekLink.

Table4.10.3 Programming Error Codes
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<Err
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TtkUnk
c:omrnanded
h••toft
bKIusuemp
walnot
relched .I'l.r
20mlnutn
R••ttac:h 25­
pInCOMector

to backof
Jlmpl.
module.
Pow.rup
Jlmple
modul•.

V'l

Vu

Pro~rfy connect
No waterlUpply. II hot

wat..-pr.lent?

....----No

No

~mov. 2Sopln
va c:onnte:tor
fromr.,rof
ample module.
uun LEO
lIIumlnltedon
vllv. c:ontrol
board1

v..

RemoveJ1
fromth.
t.mper.tur.
c:ontrol board.
Jumper J1 pin1
to pin 3.11 Ul1
LED illuminated
on VIJon (Ontrol
baird?

IsU11 LED lIlumlnltedon
v.1vec:ontrol board?

Reset Simplemodule .nd
conc;entr.tor. Allow un/Uto

perform Inltlillelf·tats.
Ishot w.t.r praent?

Incr..-nentilly
v.1ffy c:ontlnulty
of c:ompon.nu of
hot wat.r t.nk
Issembly(•.g.
prenure swltc:h,
h.,t.,., 184C
therm.1 cutout).
Repl.c:e
nectsJlry
c:ompon.nts.
Pow..-up Jlmpl.
module.

Rlplac:e power
supplyF2fUle.
Powerup
Jlmple modul•.

Replac:. VIIv.
c:ontrol bairil.
Powlrup
Slmpl. module.

No

r----------------I
I
I
I No__oJ

V.l----......

AQUATEK 70 LIQUID VIALAUTOSAMPLER ill-MAINTENANCE ANDTROUBLESHOOTING

I
No

J.
Chec:kAC
wirIng hlm.u
to valv. control
board; repairIf
nKtsury.

Ch«k
c:ontlnulty of F2
fuseon pow.r
lUpply.
II fultOK1

Vu-

v..

Verify J81s
properly
connected to
v.lve control
board.Pow..­
upJlmple
modul.'nd
m••lur. VAC It
J8 (pIn31nd
pin5).
IlVACl151240?

Powtrdown
umple module
and Ic:c:.uorlu
RemoveJ11
fromv.lv.
control board
and verify
r.lllt.nc:.b
144W+!·10%
withohmtt.r.
Isrtsbt.nc:.
144W+!·10%?

Troubleshoot the Sample
Module Hot Water Tank

......'.....', .. ',. ,'" ......,...... u . .,.· .......'" " .... ~.',' .. ',w,w<•. '.. '•• ,."',.'. ,",',••.,',',.' ••,•• ,•••••'••.••'.~.....'"',.,.:.,........."'.' ...+ ....,,'~:':•.,.,.", .w~'""....',..,,'....:.:.....~;._ .......'., ........'.' ,....,.'.,.:-......,~'.," ,>,",'" ,.,.',:,.', ':......'.:.,'.', ~..... , •• , ., ..... -.-..,.,.~.,•• '", ... ' •• ,'.........,~,.'.""'""".

Figure 4.11.1 Sample Module Hot Water TankTroubleshooting Row Chart
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Use an electronic thermal conductivity
detector and helium asthe pressurizing
gas. If an electronic leak detector Is not
available, use a 1:1 solution of
isopropanol and water. Apply a drop or
two of the solution to the suspect
fitting. If the solution bubbles, there is a
leak.Usethe solution sparingly to
prevent contaminating the fittings.

ContlnuedH'

Before Leak Checking the AQUAT.k
70 System

1. Make sure the Helium gas supply Is
connected to the sample module
and that the system pressure Isset
to 20 psi.

2. Refer to sections 4.1.2 and 4.1.3 In
this chapter for safety consider­
ations and Instructions for rernov­
Ing the sample module cover.

3. Refer to the troubleshooting flow
chart (Figure 4.12.1) and the color
leak check flow diagrams (Sectlon
5.3) for leak troubleshooting
guidelines and details.

Importantl
Do not use any type of soap solution
'(for example, Snoop~) to check for
leaks.If soap gets In the lines, It will
cause Increased background, adsorp­
tion, and other analytical problems.

4.12 Isolate and Troubleshoot.
Leaks

Pleaseusethe highlighted flow paths
and check points of the LeakCheck
Diagrams asvisual aids in Chapter 5 for
troubleshooting.

Causesof leaks typically Include the
following:

• A loose nut where the pneumatic
(gas) line enters a valve or other part.

• A ferrule (fitting Inside the nut) that Is
damaged,wom,or missing.

• A break or hairline crack on a pneu­
matic line.

• A fitting that Isthe wrong size or
type.

Allow the concentratror, sample
module, and autosampler to warm up
for at least thirty minutes before you
leak-check the system. If you leak-check
the system before the fittings have had
time to reach operating temperature
and expand, you will find leaks.A useful
leak checking tool Isan electronic
helium leakchecker.

Important!
If you tighten fittings before the system
has pressurized and warmed to
operating temperature, you can
severely damage the ferrules Inside the
nuts.You could also strip the threads on
the nuts and not be able to remove
them.

4-18
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IsflowI'IIt.450­
550mUmln (+/-10)1

--------,
I
I
I
I

M"'UNflow rate
at .nd ofSImple
Moduletranafer line

,...-....--NO-------I (beforlllpllrgevessel
on conc.ntrator).

Meaaur. flowrate at
endof Ample loop,
SampleValv.COMM

NO (common) port.

Isflow I'IIte 450-

NO 5SOmUmln (+/-)0)1

NO
YO

M_r. ow rat. at
Port 1 Hne end of 4-

NO
port ISValve.

Isflow I'IIt.450-
JlOmumln (+/-10 1

YO

PlaceII d.an, empty 40 ml sampl. vltil(withnew Apt'll In
Position 1 ofthuutosamp!ertray.

CreateM.thod InT.kUnk that does not add IS to sample.Todo so:
1. InMethodEditor SUHn, tum FillISoption Off.
2. SaveMethodas A70_nolS.mth and closescrHn.

CreateSchedul. for saved Method.Todo 10:

1. InSchedule Control sa"", type number lin Startand Stop
fields offirstlint.

2. alck Mtthod button and select A70_nol5.mth.
3. Typenumber1 InRPS field.
4. alck S1iND, then OK.

St.p systemto advanc. to and holdIn P.....urlz. Vllil mode. To
dOlO;

1. In theTekUnk Control SO"n, dIck mp untlll}'Stem
r.aches P.....urlze VIal.

2. alck HOLD.

Step IYItem to advanc. to and hold
InSampl. Tra""er mode.TodolOr

1. IntheTekUnk Control Screen,
dIckST!Puntilsystemreaches
Samplefran"••

2. alck HOLD.

------+

Checkthe
M.aauNValve

ns Control Yoltall' at J:t,
Position 'A'andBoard UiD•. J3,PosltIon'O'VIS

Arethe LED. ontheValv.

labeled 'A' Control8oIlrd.

and 'O'(at utI
bVo!ta 1:tVllit?

M...ur.
voltag. at J:t,
Posltlon'C'on
the Valv.Control
Board.

NO

1--..-----------
I
I

NO

Isthe LED
labeled 'e' (at
UtI lit?

AQUATEK 70LIQUID VIAL AUTOSAMPLER ,I: MAINTENANCE ANDTROUBLESHOOTING

Check the
Sampl. Module
Valv. Control
BoardLfDs.

b flowrate 450­
550mUmln (+/-)0)1

M.UUN flow rat.
exttlngthe DRAIN
output port on r.ar of
SampleModule.

NO

Rgure 4.12.1 Sample Module Leak and GasFlowTroubleshooting Flow Chart
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Standby LeakCheck

1. Step the concentrator to Standby
mode.

2 Usea Helium leak detector to
check the points as Indicated In
Figure 5.3.1.

FJIIlnternalStandard LeakCheck

1. Step the concentrator to Fill IS
mode.

2 Usea Helium leak detector to
check the points (fitting and ports
of Sample Module) as Indicated In
Figure 5.3.2.

Sample Transfer L.ak Check

1. Step the concentrator to Sample
Transfermode.

2. Capthe sample transfer line
reducing fitting (fitting that fits
over the concentrator sparge
vesselside arm). Remove and set
aside the end nut from the fitting.
Attach a 1/8" plug nut to the male
end of the fitting to cap the end of
the tubing. Tighten the fitting.

3. Usea Helium leak detector to
check the points (fitting and ports
of Sample Module) as Indicated in
Agure 5.3.3.

4-20

Pressurize Vial LeakCheck

1. Place a clean sample vial (using a
new septum) up onto the
autosampler sample needle. It Is
very Important to use a brand new
septum for this leak check proce­
dure to ensure an accurate reading.

2. Capthe Drain port on the rear of
the sample module using a 1/8"
plug nut.

3. Step the concentrator to Pressurize
Vial mode and Hold.

4. Usea Helium leak detector to
check the points (fitting and ports
of Sample Module) as Indicated In
Figure 5.3.4.

Note:

If tightening a fitting does not stop a
leak,look for other causes, but never
overtighten the fittings.

If you are unable to determine and/or
solve a leak problem, please contact the
Customer Support Center at (800)874­
2004.



4.13 Isolate and Troubleshoot
Gas Flow Rate Problems

Please use the highlighted flow paths
and check points of the GasFlow Rate
Diagrams as visual aids In Chapter 5 for
troubleshooting.

Gasflow rate problems can be caused
by tubing restrictions, bad valves, loose
or bad fittings, and other conditions.

Allow the concentratror, sample
module,and autosamplertowarm up
for at least thirty minutes before you
check gas flow rates.If you check
system gas flow rates before the fittings
have had time to reach operating
temperature and expand, you might
obtain false flow rate readings.Use a
gas flow meter to measure gasflow
rates.

If you are unable to determine and/or
solve a leak problem, please contact the
Customer Support Center at (800)874­
2004.

Before Flow Checking the AQUATek
70 System

1. Make sure the Helium gassupply is
connected to the sample module
and that the system pressure Is set
to 20 psI.

2. Refer to sections 4.1.2 and 4.1.3 In
this chapter for safety consider­
ations and instructions for remov­
Ing the sample module cover.

3. Referto the troubleshooting flow
chart (Figure 4.12.1)and the color
gas flow diagrams (Section 5.4) for
gasflow troubleshooting guide­
lines and details.

Standby Gas Flow Rate Check

1. Step the concentrator to Standby
mode.

2. Disconnect the ISflow restrictor
outlet fitting (see Figure 5.4.1).

3. Measure the flow rate at the ISflow
restrlctor outlet. If you do not get a
reading of450-550 celmln from
the ISflow restrlctor, then check
flow rates at outlets of the previous
fittings and valves In flow path (see
highlighted path In Figure 5.4.1).

Sample Transfer Gas Flow Rate Check

1. Step the concentrator to Sample
Transfer mode.

2. Remove and set aside the end nut
from the reducing fitting that
attaches the sample transfer line
from the sample module to the
concentrator sparge vessel side
arm.

3. Measure the flow rate exiting the
sample transfer line. If you do not
get a reading of450-550 cclmln,
then check flow rates at outlets of
the previous fittings and valves In
flow path (see highlighted path In
Agure 5.4.2).

Contlnued.:
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Purge Lines Ga, FlowRateCheck

1. Step the concentrator to Purge
Linesmode.

2. Disconnect the top sample line
fitting from the top of the
autosampler sample needle.

3. Measurethe flow rate exiting the
sample line. If you do not get a
reading of450-550 cdmln from
the IS flow restrlctor, then check
flow rates at outlets of the previous
fittings and valves In flow path (see
highlighted path In Figure 5.4.3).

Fill Internal StandardGas FlowRate
Check

1. Replace the sample module IS
vessel with a clean,empty ISvessel.

2. Step the concentrator to Fill IS
mode.

2. Removeand set aside the end nut
from the reducing fitting that
attaches the sample transfer line
from the sample module to the
concentrator sparge vesselside
arm.

3. Removeand set aside the drain
tubing from the Drain port on the
rear of the sample module.

4. Measurethe flow rate exiting the
Drain port. If you do not get a
reading of30 (± 10) ml/mln, then
check flow rates at outlets of the
previous fittings and valves In flow
path (seehighlighted path In
Figure5.4.4).

----------------------------4-22
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FIgUre 5.4.1 Gas Flow Rate Check Points; Standby Mode
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5.5.1 Sample ModuleSolenoid Valves and
Corresponding Areas of Valve Control Baird

VaIYI Controlloard
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ToTtmp.
Control
BoIrd

T.~

i\', '('IHllly 1"",( I ipt iun Ht,I'"lt'III" I:

Comput.r Boards
Temperature Control Board 7
Valve Control Board 5
Valve Assemblf.s
3-Way, Dratn Valve 4
3-Way, Pressurize Valve 10
3-Way, Sample Valve 9
3-Way, Transfer Valve 11
4·PortValve (100/115V or 1
230V)

Cables/Wfrfng Hameues
Cable, 2S Pin, Female 16
Cable, 9 Pin, Male 15
Wiring Harness, (AC) 13
Wiring Harness, (DC) 12
Wiring Harness, Temperature 14
Control Board
Electronfc Parts
LED, Square .370x .270, 8
Yellow
Power Entry Module 2
Power Supply, 65W 3
Pressure Switch, 1/8 NPT, 17
10-l00PSI
Water Reservoir/Heaters 6
(100/115V or 230V)

ToAuto..mpltr

ToJ14

ToConctntrator

ToPower
Supp/yJ2

ToPowlr
SupplyJl

5.6 AQUATek 70 Wiring Diagram
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5.7 Sample Module Part Assemblies
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19

12

17

14

10

Needle Assen"bly,
Al!t'_if.JIIw

T~~1/16

Tee, 1/16 , Brass

Wae Ressrvolrllleater
(100'1151' or 23OV)

Press1.n Gauge, 0-30 psi

Tee, 118 , Brass

Presst.rize Valve,3-W,

FIowF

Toggle VaNe, 3-W

_ lestrictor,SS Tlt*lg,
1/16 x.OO4

8al'T1* VfJlve, 3-W~

T~ Tenon.118

Tt.mk1g. Pressl.n Gauge. 6
TlkIila. Tafton, 1/16

Trans:ier VaIYe, 3-W1tY

Stand8fd Vessel wllh IN
0.330 10

Pressu'eSwIch, 118 NPT,
1o-100PS1 .

Drak1 Va.IYe, 3-W~

5arr1*l Mom!: RttIng, 112 •
1/16

S8nl*l loop, Teflon
(S, 20, or2SmL)

Pressln AegUator, Valve,
1/16 Fl, o-eo psi

IS VaIYe, 4-Port
(100/115V or 23OV)

Check: VfJlw

Aaw RestrlctOl,Union,
1H6 , 5OOcc, with FIWngs

Figure 5.8.1 5ampIe ModuJe Flow Path Assemblies

~PR£SSURE
SWITCH

AU'TOSAIfPl[R

fEEDlE

TO COHCEHTRATOR

DIWIIw.... q:ppr

WmR. fl) "U' I

U'I
~..

",tllltttaetttt_telliitalllillalill

-------- ,

~

-.~

]
,--~

~".-



"'"","',"', :r~~'~('~111~1~~*,,'i1l:Wit·,,··!·r,·
.' ,I- '''','' .,:',"'" .



:..
~-­....
. a
~.....,..
~,.
~

~

INDEX
• l1li •••••••• l1li ••••• _ •••• f1111l'l1lll1tl llO 1II QlI $1\ Ie IW





Symbols

.bin extension 3-5
20XX 3-13
3-port solenoid valves 1-4
35-posltion tray 1-4
4-port valve 1-4
70-posltlon vial cooling tray 1-4

A

Abort
Current Sample 3-22
Entlr~ Schedule 3-22
Sample 3-22
Schedule 3-22

AlC Outputs 3-9
Active Concentrator 3-9

Selecting 3-8
Ambient 3-10
Assemblies

Flow Path 5-21
Auto 3-21
Autosampler 1-3, 1-5, 3-16, 3-19

Setup 2·8

B

BlankWater 1-3

c
Certifications 1-5
COM 3-8

Port number 3-5
Concentrator 1-3, 1-4
Configuration

Concentrator 3-9
System 3-10

Configure
COMPorts 3-8
Instrument 3-9

AQUATEK 70LIQUID VIAL AUTOSAMPlER *' INDEX

Connections
Autosampler 2-8, 2-9, 2-10,

2-11, 2·12, 2-13, 2-14
Electronic 2-16
Pneumatic 2-17
Wat~r Bath 1-4

Cryofocuslng Trap 3-10, 3-13
Customized Methods 3-11

D

Data 1-3
Default

Method Parameter 3-13
A70_5ml.mt3 3-13, 3-14
A70_25ml.mt3 3-13, 3-14

Diagrams
Modes 5-2•••5-9
GasFlowRateCheck 5-14.••5-17
H20 TransferProblem Areas 5-18
LeakCheck 5-10..•5-13
Part Assemblies 5-20, 5·21
Wiring 5-19

Drain 3-21
Drinking water 1-4

E

Electronic Control 1-4

F

Flash Upgrade 3-5
Burning Process 3-6
Performing 3-5
Program Ale 3-5

Fuse
Replacement 4-6

III



i.::~· "

•••G M
~.,

Gas Method ..,Requirements 1-5 Button 3-18 ..GasFlowRa~e Control 1-3
Diagrams Development 3;,;11 ."Fill Internal Standard 5-17 Editor 3-11, 3-12 •Purge lines 5-16 exit 3-12

SampleTransfer 5-15 Save 3-12 •Standby 5-14 Parameter 3-14 ..Troubleshooting 4-19, 4-21, 4-22 Schedule 3-16
GC Run 3-18 ..

Handshaking 3-10 Worksheets 3-24 ..Storage 1-4
H Methods 1-4 •Helium 1-5 Default •A70_25ml.mt3 3-13Hold 3-21

. A70_5ml.mt3 3-13 •Hot Water
Heater 4-11 Pre-programmed 1-4 •Replacement 4-11 Deleting 3-12

•Using 3-11Troubleshooting 4-17
Min/Max Field 3-13 •Modes

Defined P-
Instrument Control 104- Bake 3-15

L-Interface Board 4-11 BakeRinse 3-15
Internal Standard BakeSweep 3-15 •Accuracy 1-4 BakeTransfer 3-15 •Interrupt 3-21 Desorb 3-15 •ISMount 2·22 Desorb Ready 3-15

J Dry Purge 3-15 •Fill Internal Standard 3-15

Jll4-11 Pressurize Vial 2-22, 3-15 •Purge 3-15 •L Purge lines 3-15 ..Purge Ready 3-13, 3-15
leak Check 2-22, 4-18 SampleTransfer 3-15 •Diagrams Standby 3-15, 3-18 •Fill Internal Standard 5-11 Diagrams 5-2

Pressurize Vial 5-13 Bake 5-3 •SampleTransfer 5-12 BakeRinse 5-9
Standby 5-10 BakeSweep 5-8 •Troubleshooting 4-18•••4-20 BakeTransfer 5-6 ..

Desorb 5-6 ..Desorb Ready 5-3 ..
Iv 1;--..

" i ,'" "~.,
~, I ~ ~I. ~l

~,l .: .... ," .~!. .'



Fill Internal Standard 5-5
Preheat 5-3
Pre-purge 5-3
Pressurize Vial 5-4
Purge 5-3
Purge lines 5-8
Rinse lines 5-7
Sample Transfer 5-6
Standby 5~3

o
Operating Sequence 3~11

Changing 3-21
OptlRlnse 1-4

p

Parameter Value 3-13
Part

Assemblies
Electrical 5-19
FlowPath 5-21
Mechanical 5-20

Power
EntryModule 4-6
Supply 4-7

Replacement 4-7
Pressure

Regulator 4-12
Replacement 4-12

Switch 4-9
Replacement 4-9

Prime
IS 3-19
H:,o 3-19

R

Recirculating Cooling Bath 1-4
Requirements

Environmental1-5
Power 1-5
System 3-3

Rerun Sample 3-22
Reservoir 1-3

AQUATEK 70 LIQUID VIAL AUTOSAMPlER iff INDEX

External 1-3
Kit 1-4

Reset 3-21
Rinse

Kits 1-4
Reservoir 1-3
Water 1-3

ROM
ImageFile 3-5
Version 3-6

RPS 3-18
Runs PerSample 3-18
Run Samples 3-20

5

Safety 1-6
Sample

Front-panel 3-17
Glassware

Emptying 3-21
Loop 1-4, 3-14, 4-10

Replacement 4-10
Module 1-3, 1-5
Pathway 1-3, 1-4
Run 3-23

Checklist 3-23
Setup 3-19
Types 1-4
Vial 1-4, 3-18

Schedule
Control 3-16, 3-17
Help 3-17
Print 3-18
Send 3-18
Start Position 3-18
Stop Position 3-18

Sediment 1004-
Send 3-18
SolenoidValves 1-4

Replacement 4-8
Specifications 1-4

EnvironmentRequirements 1-5
Relative Humidity 1-5

Standard 1-3,2-22

v



~..
Injection System 1-4 U

.,..Solution 1-3
Standby 5-3 Ultra-high Purity .1

\.--
Hold 3-21 GasSupply 1-5 ..LeakCheck 5-10 Unit Control 3-9

Start 3-20 V iii
Start and Stop 3-17 ..Step 3-21 Values

[to] Bake 3-21 Valid 3-10 Wi-
[to] Standby 3-21 Valve ..System Description 1-3 Configurations 5·2

T Control Board ..
Replacement 4-5 ..

Tap Solenoid

Water 1-3 . Replacement 4--8 ..
Rinse Kit 1-3, 1-4 Valvlng 1-4 ..

TekLink 1-3, 1-4 Vial -
Configure Ports 3-6 Cooling 1-4 --Control Screen 3-7 Sampling Device 1-4 ...
Errors Transport 1-3 --

Operation 4-14, 4--1 5 VOC 1-3 ..
.' .'.'

Programming 4--16
W ..

UserInterface 4--1 3 . .....
Messages 3-13 Warranty 1-5 \
Installing 3-3 Wastewater 1-3, 1-4 ~

Starting 3-3 Water 1-3 ..
Temp Zone Status 3-18 Weight 1-5
Temperature Wiring Diagram 5-19 ..

Operating 1-5 -

Storage 1-5 X .-
Trays 1-4

XVZautosampler arm 1-4
..

Troubleshooting ..
HpTransfer 5-18
Out-ot-Range Error 3-18 ..
TekLink ..

Connect Error 3-6
LostCommunication 3-6 ..
RS232 Error 3·8 ..
Troubleshooting Errors 4-14,

4--15, 4--16 ..
TurboCool 3-10 ..-..

.....~
vi ....
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